# Contents

*What’s New*  
Overview  
Details  

**Chapter 1 △ How to Use This Document**  
Using This Document  
Audience  

**Chapter 2 △ Overview**  
Introduction to the SAS/ACCESS Interface to SAP BW  
Accessing SAP BW Data Using the SAS/ACCESS Interface to SAP BW  
Using SAS/Connect with the SAS/ACCESS Interface to SAP BW  

**Chapter 3 △ Getting Started**  
Using the SAS/ACCESS Interface to SAP BW Desktop  
Using and Managing Logon Profiles  
Setting Up the Required SAS Libraries  
Defining the Local Application Defaults  

**Chapter 4 △ Extracting and Browsing SAP BW Metadata**  
Overview of Extracting and Browsing SAP BW Metadata  
Extracting SAP BW Metadata  
Browsing SAP BW Metadata  
Saving and Running SAP BW Metadata Extraction Programs  

**Chapter 5 △ Extracting InfoCubes and Reading ODS Data into SAS**  
Overview of Extracting InfoCubes and ODS Table Data into SAS  
Extracting InfoCube Data from SAP BW  
Extracting ODS Table Data from SAP BW  
Saving and Running SAP BW Data Extraction Programs  

**Chapter 6 △ Exporting OLAP Metadata to SAS**  
Overview of Exporting OLAP Metadata to SAS  
Exporting OLAP Metadata to SAS/EIS  

**Appendix 1 △ Recommended Reading**  
Recommended Reading  

**Glossary**  

**Index**
What’s New

Overview

The new features and enhancements for the SAS/ACCESS 9.1 Interface to SAP BW include

- support for SAP BW, Release 3.0
- changed data capture (CDC) processing that enables you to identify and extract only the data in your ODS tables and InfoCubes that has changed since your last extraction
- enhanced performance when using the Load Metadata wizard to extract your SAP BW metadata
- a logon process that no longer requires CPI-C logon parameters to be used.

Details

- The SAS/ACCESS Interface to SAP BW now supports all SAP BW releases from SAP BW, Release 2.0B, through SAP BW, Release 3.0. The SAS/ACCESS Interface to SAP BW is now compatible with SAP BW systems that contain transactional operational data store (ODS) tables and transactional InfoCubes that were introduced in SAP BW, Release 3.0.

  Note: The SAP BW transactional ODS tables and transactional InfoCubes do not support changed data capture (CDC) processing.

- The SAS/ACCESS Interface to SAP BW now provides a new method of extracting data from the ODS objects and InfoCubes in your SAP BW system. When extracting data from ODS tables and InfoCubes, you can either use full update processing, which extracts all of the data in the selected ODS table or InfoCube, or you can use changed data capture (CDC) processing. CDC processing enables you to extract only the data that has changed since your last extraction. For more information, see “Using CDC Processing When Extracting InfoCubes” on page 52 and “Using CDC Processing When Extracting ODS Table Data” on page 55.

- The Load Metadata wizard has improved performance when extracting metadata. Now, the SAS/ACCESS Interface to SAP BW uses an ABAP function that issues a
single call to your SAP BW system rather than issuing multiple calls. This reduces the amount of time required to extract large amounts of metadata from the ODS objects and InfoCubes in your SAP BW system.

In previous versions of the SAS/ACCESS Interface to SAP BW, the logon profiles required that CPI-C parameters be used when logging on to your SAP BW system. Now, the CPI-C parameters are no longer used when you log on to your SAP BW system. The logon utility enables you to access the following windows in which you will need to enter your logon parameters:

- Logon to SAP BW window
- Advanced Parameters window
CHAPTER

1

How to Use This Document

Using This Document

*SAS/ACCESS 9.1 Interface to SAP BW: User’s Guide* describes how to use the SAS/ACCESS Interface to SAP BW. This document provides primary support for the SAS/ACCESS 9.1 Interface to SAP BW.

The SAS/ACCESS Interface to SAP BW enables you to extract and browse InfoCube and ODS object metadata from SAP Business Information Warehouse (SAP BW), and then import InfoCube and ODS data into SAS. In addition, you can use the interface to export OLAP metadata about an SAP BW InfoCube to SAS/EIS. The interface enables you to retrieve SAP BW data both interactively and in batch mode.

Audience

This document is intended for applications programmers, warehouse administrators, system administrators, and other users who are comfortable with their own operating environment and are reasonably familiar with either SAS or SAP BW. It is assumed that users are completely unfamiliar with using both of the systems together. The glossary provides definitions of terms that might be new to a user who is unfamiliar with either system.

This document provides tutorial instruction for a novice user of the SAS/ACCESS Interface to SAP BW. After you have mastered the tutorial, you can use this document for reference.
Introduction to the SAS/ACCESS Interface to SAP BW

The SAS/ACCESS Interface to SAP BW is an interface to SAP Business Information Warehouse (SAP BW), which is the warehousing tool that SAP AG offers for multidimensional reporting and operational reporting. The SAS/ACCESS 9.1 Interface to SAP BW supports all SAP BW releases from SAP BW, Release 2.0B, through SAP BW, Release 3.0. The SAS/ACCESS Interface to SAP BW is compatible with SAP BW systems that contain transactional operational data store (ODS) tables and transactional InfoCubes that were introduced in SAP BW, Release 3.0.

The SAS/ACCESS Interface to SAP BW is a metadata-driven application that enables you to extract metadata, InfoCube data, and ODS object data from your SAP BW system. The extracted metadata enables you to determine which InfoCube and ODS object data you want to extract. After the data is extracted, you can

- include SAP BW data in a SAS warehouse or data mart.
- merge SAP BW data with other data sources.
- use the export function in the SAS/ACCESS Interface to SAP BW to export OLAP metadata. You can then use the OLAP metadata with SAS/EIS in order to produce detailed reports from your SAP BW data, or use the OLAP metadata with SAS OLAP tools in order to gain rapid access to business data through multidimensional data viewers.
- import SAP BW data into Enterprise Miner, which enables you to perform data mining.
- analyze SAP BW data using SAS analytical tools such as SAS/ETS and SAS/OR.
- re-use SAP BW data in Customer Relationship Management (CRM) solutions, Strategic Vision, and so on.

SAP BW replaces SAP R/3 reporting systems as the reporting component within the mysap.com solutions. SAP BW stores data in multidimensional data structures that are called InfoCubes, which cannot be accessed directly. Therefore, to generate reports from the InfoCubes, customers normally use the presentation layer in SAP BW to display
spreadsheet-type views of QueryCubes. QueryCubes are subsets or views of the InfoCube that are typically defined in SAP Business Explorer (BEx).

The SAS/ACCESS 9.1 Interface to SAP BW includes changed data capture (CDC) processing that enables you to identify and extract only the data in your ODS tables and InfoCubes that has changed since your last extraction. However, changed data capture (CDC) processing is not supported with transactional SAP BW InfoCubes and ODS objects because transactional InfoCubes and ODS objects do not use the change log table.

The SAS/ACCESS Interface to SAP BW offers an alternative method for accessing the data in your SAP BW system and also enables you to view InfoCube and ODS object metadata. By enabling view access to the SAP BW metadata, the SAS/ACCESS Interface to SAP BW helps you better utilize the data that is stored in an ODS object or InfoCube. After you know the contents of the data structure, you can extract the data from your SAP BW system and save it in SAS data sets and views. You can then generate reports from these SAS data sets and views. Therefore, through the use of SAP BW metadata, the SAS/ACCESS Interface to SAP BW enables you to know more about your SAP BW data, to better access the data that is stored in SAP BW ODS objects and InfoCubes, and to use the analytical power of SAS software to analyze your SAP BW data.

---

**Accessing SAP BW Data Using the SAS/ACCESS Interface to SAP BW**

**How Data is Stored in SAP BW Systems**

SAP BW systems store data in InfoAreas, which are logical collections of data that are based on data models and business rules derived from the enterprise model of SAP R/3. InfoAreas can contain ODS objects, which have only one table of non-aggregated data, and multidimensional data structures called InfoCubes, which are based on the snowflake schema data model. InfoCubes consist of

- 1 fact table
- $n$ dimension tables
- $n$ surrogate ID (SID) tables
- $n$ text tables
- $n$ master data tables
An InfoCube is a set of relational tables that contains InfoObjects. InfoObjects are key figures, which are quantifiable values, and characteristics, which are used to calculate and present key figures. In an InfoCube, the fact table is the only link between each of the dimensions in the InfoCube. An InfoCube is structured as follows:

- **fact table** contains the key figures, which are quantifiable values.
- **dimension tables** contain the characteristics that are used to analyze and report on the key figures.
- **SID tables** specify tables in the SAP BW system that contain surrogate IDs. SID tables link the master and hierarchy tables outside the dimensions of a star schema.
- **text tables** contain descriptive text that might be time or language dependent.
- **master tables** contain attributes that are used for presenting and navigating reports in SAP BW. They can, however, be extended to include other data. Master tables are also time-dependent and can be shared by multiple InfoCubes.

## How You Can Access Your SAP BW Data Using SAS Software

SAS software provides many methods for accessing the data that is stored in your SAP BW system, depending on your business needs:

- **Enterprise Guide and SAS/ACCESS Interface to OLE DB** use OLE DB for OLAP (ODBO) to access QueryCubes in SAP BW. In this context, SAS serves as an ODBO client application in order to extract data from SAP BW QueryCubes. This method of accessing SAP BW data enables Microsoft Windows users to query QueryCube data and save the subsets of SAP BW data as SAS data sets. The queries must be predefined within the SAP BEx. This method of accessing ODS objects and InfoCubes is best for retrieving small amounts of data and generating short reports.
SAS/ACCESS interfaces to Oracle, Adabas, and Informix enable you to directly access the database in which the InfoCubes are stored. However, without knowledge of the database and InfoCube structure, it can be difficult to analyze or understand the data. This method of accessing ODS objects and InfoCubes provides complete access to the data, as well as access to the metadata, but it does not provide access to the business rules or application logic that define how the ODS objects and InfoCubes are structured.

SAS/ACCESS Interface to R/3 enables you to access SAP BW data by communicating with your SAP BW system through remote function calls (RFC). Because SAP BW uses SAP R/3 as a repository for SAP BW, the SAS/ACCESS Interface to R/3 can read data through the SAP BW application layer and can read tables that are stored in SAP BW. This method of accessing the InfoCube and ODS data enables you access the SAP BW data and the tables containing the SAP BW metadata.

SAS/ACCESS Interface to SAP BW enables you to use the RFC technology from the SAS/ACCESS Interface to R/3 to access the ODS objects and InfoCubes, rather than accessing only the QueryCubes. It also enables you to extract and browse the InfoCube metadata as well as extract the InfoCubes. The high performance of the SAS/ACCESS Interface to SAP BW and the ability to access multidimensional data and save it in a multidimensional SAS format make this method of accessing the SAP BW data the best method for mass extraction and processing of SAP BW data.

How Data Is Extracted Using the SAS/ACCESS Interface to SAP BW

When the SAS/ACCESS Interface to SAP BW extracts an InfoCube, it simplifies the snowflake schema of an InfoCube to a star schema that consists of

- 1 fact table
- \( n \) dimension tables
- SAS formats.

Figure 2.2  SAS Views of Snowflake Schema Tables Converted to SAS Data Sets Containing Star Schema Tables
During the extraction process, the SAS/ACCESS Interface to SAP BW creates views that represent the fact, SID, dimension, text, and master tables that make up the SAP BW InfoCube. The views are then used to create a star schema from the snowflake schema. The star schema is created by merging the SID and master tables with the dimension tables. The text tables are used to create SAS formats for logical keys and class variables. The fact table is stored as a SAS view or SAS data set. The dimension tables are stored as SAS data sets. The SAS formats are stored in a SAS catalog. The SAS/ACCESS Interface to SAP BW simplifies the data structure of InfoCube data from a snowflake schema to a star schema in order to improve performance for data exploitation.

Because active ODS objects consist of only one table, the SAS/ACCESS Interface to SAP BW does not convert an ODS object to a star schema. Instead, the active ODS data is extracted to a single SAS data set or view.

**Using SAS/Connect with the SAS/ACCESS Interface to SAP BW**

When you use the SAS/ACCESS Interface to SAP BW to extract data from an SAP BW ODS object or InfoCube, the interface uses SAP BW metadata in the extraction process. The interface requires you to extract the SAP BW metadata to the Data Dictionary Library, which is a SAS library or reference that identifies where the metadata is stored on the local machine, and it uses that metadata when extracting ODS objects and InfoCubes. When operating on a remote host environment, you might want to store a copy of the metadata on that remote host and use that copy of the metadata when extracting data from an SAP BW ODS object or InfoCube.

When working with a remote host on which you want to store a copy of the extracted SAP BW metadata, you must first extract the SAP BW metadata to the local machine. Then you can connect to the remote machine and upload the extracted metadata. The process for storing the extracted metadata on a remote host involves

- extracting the metadata to the local machine
- connecting to the remote machine, which you can do using SAS/CONNECT
- uploading the metadata to the remote machine, which you can do using PROC UPLOAD.

In addition, you must connect the remote host to your SAP BW system with RSUBMIT by using the same connection ID that you used to connect the local machine to your SAP BW system.

The following sample code demonstrates how to connect to a remote host using SAS/CONNECT, upload SAP BW metadata and a logon profile to the remote host, and connect remotely to the SAP BW system. You can modify this sample code as needed and use it to prepare a local SAS/ACCESS Interface to SAP BW session to extract ODS object or InfoCube data from an SAP BW system and upload it to a remote host.

```sas
/*
This sample program demonstrates how to
- connect to a remote host using SAS/CONNECT
- upload BW metadata and logon profile to remote host
- connect remotely to SAP BW system.
This code can be run to prepare a local SAS/ACCESS to SAP BW session for extracting ODS object or InfoCube data from an SAP BW system to a remote host. */
```

Overview △ Using SAS/Connect with the SAS/ACCESS Interface to SAP BW 7
/* Sign on to the remote host. */
filename rlink 'd:\sapconn\tcphp_accbw.scr';
%let duke=duke.eur.sas.com;
options remote=duke;
signon duke;

rsubmit duke;

/* Assign libnames for SAP BW metadata and data remotely. */
%inc 'bwlibrefs.sas';

/* Upload SAP BW metadata from the local machine to the remote host. */
proc upload inlib=BWLIB outlib=BWLIB;
 run;

/* Upload the logon profile to the remote host. 
In this example, the logon profile has been saved in library 
SASUSER. See the section about Batch Operation in the SAS/ACCESS 9.1 
Interface to R/3 Users Guide. */
proc upload data=SASUSER.R3CONN out=SASUSER.R3CONN;
 run;

/* Connect remotely to SAP BW. */
%r3connb(profile=BW,libref=sasuser,function=OPEN);
endrsubmit;

/* This sample program shows how to disconnect remotely 
from SAP BW after the InfoCube has been extracted. It 
also signs off of the remote host. */
rsubmit duke;
/* Close remote connection to SAP BW system. */
%r3connb(profile=BW,libref=sasuser,function=CLOSE);
endrs_submit;

/* Sign off of the remote host. */
signoff duke;
Getting Started

Using the SAS/ACCESS Interface to SAP BW Desktop

Introduction to the SAS/ACCESS Interface to SAP BW Desktop

Accessing and Using the SAS/ACCESS Interface to SAP BW Desktop

Using and Managing Logon Profiles

Overview of Logon Profiles

Creating and Using Profiles to Log On

Creating and Using a New Logon Profile

Modifying and Using Existing Logon Profiles

Viewing and Managing Logon Profiles Using the List of Connections Window

Introduction to the List of Connections Window

Viewing and Managing Open and Available Connections Using the List of Connections Window

Logging Off

Setting Up the Required SAS Libraries

Overview of the Required SAS Libraries

Defining the Required SAS Libraries

Defining the Local Application Defaults

Overview of the Local Application Defaults

Defining the General Application Defaults

Defining the Data Dictionary Defaults

Defining the Miscellaneous Default

Using the SAS/ACCESS Interface to SAP BW Desktop

Introduction to the SAS/ACCESS Interface to SAP BW Desktop

The SAS/ACCESS Interface to SAP BW desktop provides four icons that enable you to easily access and use the main features of the application.
Display 3.1  SAS/ACCESS Interface to SAP BW Desktop

The following icons are available on the SAS/ACCESS Interface to SAP BW desktop:

- **Logon**: enables you to log on to the SAP BW system.
- **Local Setup**: enables you to set up application parameters and defaults.
- **SAP BW Explorer**: enables you to browse metadata that was previously extracted from SAP BW, to extract InfoCube and ODS data, and to export OLAP metadata from an SAP BW InfoCube to SAS/EIS.
- **Load Metadata**: enables you to extract metadata from InfoCubes and ODS objects that are defined in your SAP BW system.

---

**Accessing and Using the SAS/ACCESS Interface to SAP BW Desktop**

To access and use the SAS/ACCESS Interface to SAP BW desktop:

1. Start a SAS session.
2. On the command line, enter `%bwaccess` to open the SAS/ACCESS Interface to SAP BW desktop.
3. Double-click the desired icon on the SAS/ACCESS Interface to SAP BW desktop:

   ![Logon Icon](image)

   This icon displays the Logon to SAP BW window and enables you to
   - create, save, and use profiles to log on to the SAP BW system
   - display the Advanced Parameters window, which enables you to define specific connection parameters for the logon profile that you want to use
   - access the Connections menu, which enables you to log on, log off, and display a list of the open as well as available connections.
Getting Started

Overview of Logon Profiles

This icon displays the Application Setup window, which enables you to define local application defaults, such as the location in which you want to store the extracted SAP BW metadata, and so on.

This icon displays the BW Explorer window, which enables you to
- browse metadata that was extracted from the SAP BW InfoCubes and ODS objects, including detailed information about the data models, tables, and InfoObjects
- view and print data in tables and InfoObject details
- extract data from the InfoCubes and ODS objects that are defined in your SAP BW system
- export OLAP metadata from an InfoCube to SAS/EIS.

This icon launches the wizard that enables you to extract metadata from the InfoCubes and ODS objects that are defined in your SAP BW system.

Using and Managing Logon Profiles

Overview of Logon Profiles

Each time that you use the SAS/ACCESS Interface to SAP BW, you must use a logon profile in order to log on to your SAP BW system. This profile contains your user ID and password, the client information for your SAP BW system, and various other logon parameters that are required to log on to your SAP BW system.

Note: Because the SAS/ACCESS Interface to SAP BW uses a remote function call (RFC) server to communicate with the SAP BW system, you must have an RFC service running when you attempt to use a logon profile in order to connect to the SAP BW system.

The Logon icon in the SAS/ACCESS Interface to SAP BW desktop displays the Logon to SAP BW window, which enables you to define a new profile or use an existing profile in order to log on to your SAP BW system.
The first time that you use the SAS/ACCESS Interface to SAP BW, you will need to create a new profile. When you have multiple logon profiles, you can have multiple open connections to the SAP BW system at one time. Therefore, it is helpful to be able to display and manage the logon profiles. The List of Connections window, which can be accessed from the Tools menu from either the Logon to SAP BW window or the Application Setup window, enables you to view and manage the profiles that are associated with the open and available SAP BW connections.

The List of Connections window enables you to

- view the parameters for each defined profile
- edit and delete existing profiles
- create new profiles
- connect and disconnect from SAP BW by using defined profiles.

For specific information about how to create, manage, and use profiles to log on to and log off of SAP BW, see
Creating and Using Profiles to Log On

Creating and Using a New Logon Profile

To create and use a new logon profile:

1. Double-click the Logon icon on the SAS/ACCESS Interface to SAP BW desktop to display the Logon to SAP BW window.

Display 3.4 Logon to SAP BW Window

2. Enter the profile parameters:

   **Profile** specifies the name of the profile. The profile stores all of the parameters or values that are entered in the fields in the Logon to SAP BW window and the Advanced Parameters window.

   **Client** specifies the client identification number or client ID for the SAP BW system. The client ID must be three digits in length. If necessary, use leading zeros. For example, a client ID of 010 enables you to successfully log on to the SAP BW system, but a client ID of 10 will fail.

   **User ID** specifies the user identification number or user ID for logging on to the SAP BW system.

   **Password** specifies the password for the SAP BW system user ID that is entered in the **User ID** field in this window.

   **Language** specifies the human language that the SAS/ACCESS Interface to SAP BW uses when it extracts language-dependent data from SAP BW. For example, **EN** sets the language to English and **DE** sets the language to German.

3. Click **Advanced** to open the Advanced Parameters window.

—
4 From the General tab, enter the general logon parameters:

**Display 3.5** Advanced Parameters Window: General Tab

![Advanced Parameters Window](image)

- **Connection Id** displays a text name that you assign to the connection ID. The connection ID is used as a SAS library reference and is used by macros in the SAS program that manage the connection to the SAP BW system and access the SAP BW tables. The name is used as a SAS library reference and must follow the standard SAS naming conventions for library references.

- **Remote** specifies the connection ID for the remote SAS session. In order to read SAP BW tables into SAS data sets while running a remote SAS session, a connection to SAP BW must be established using the same connection ID. The default value for the remote connection ID is `-LOCAL-`. If you have a remote host environment and you are using SAS/CONNECT to connect to that remote host, select your particular remote host from the drop-down list.

- **Description** enables you to enter a text description for the general logon connection.

5 From the TCP/IP tab, enter the TCP/IP parameters:
Display 3.6 Advanced Parameters Window: TCP/IP Tab

- **Host** specifies the network location of the RFC server. The default value is `localhost`.
- **Port** specifies the TCP/IP port for communicating with the RFC server. The default port number is `6999`.

6. From the RFC tab, enter parameters for the remote function call (RFC) server:

Display 3.7 Advanced Parameters Window: RFC Tab

- **Host** specifies the SAP BW server to which the RFC server connects. The host name can be specified by its IP address.
- **Destination** specifies a logical name that is used by the sideinfo file. If a destination is set here, all of the other fields located on the RFC tab will be ignored and the sideinfo file content will be used instead.
- **Gateway Host** specifies the gateway host that is used by the RFC server to communicate with SAP BW. The default value is `Host`.
- **Gateway Service** specifies the communication gateway service that is used by SAP BW. The default value is `sapgw01`. 
System Number specifies the system number for the SAP BW system to which you are connecting. The default value is 0.

Function specifies the SAS function that is called as part of the SAP BW logon process. You can specify the R/3 function module that is used for RFC.

7 Click [OK] to save the parameters. The Logon to SAP BW window displays.

8 Save the profile in one of the following ways:
   - To specify the library in which the profile is saved, select the following:

     File ➤ Save

     The Save As window displays.

     ![Save As Window]

     In the Libref field, enter the library reference that specifies the library in which you want to save the logon profile.

     - To save your profile in the default library, which is SASUSER.R3CONN, click [Save] in the Logon to SAP BW window.

9 Click [OK] in the Logon to SAP BW window to connect to SAP BW.

Note: If you receive an error message indicating that the connection was refused, make sure that your RFC service has been started using the same port as specified on the TCP/IP tab.

Modifying and Using Existing Logon Profiles

To modify an existing logon profile or use an existing profile to log on to SAP BW:

1 Double-click the Logon icon on the SAS/ACCESS Interface to SAP BW desktop to display the Logon to SAP BW window.
2 Select the profile you want to use or modify from the Profile drop-down list.

3 To modify the profile:
   a Modify the Client, User ID, Password, and Language fields as needed.
   b Click Advanced to open the Advanced Parameters window and make changes as needed.
   c Click OK in the Advanced Parameters window to return to the Logon to SAP BW window.
   d Click Save to save the changes that you made to the profile.

   Note: For more detailed information about defining logon and profile parameters and saving profiles, see “Creating and Using Profiles to Log On” on page 13.

4 To log on to the SAP BW system using an existing or modified profile, select the profile from the Profile drop-down list and click OK in the Logon to SAP BW window.

---

**Viewing and Managing Logon Profiles Using the List of Connections Window**

**Introduction to the List of Connections Window**

The List of Connections window enables you to view the connections to SAP BW that are currently open and available. These connections correspond to logon profiles that have been defined for logging on to SAP BW. You must first open either the Application Setup window or the Logon to SAP BW window in order to open the List of Connections window.

You can use the List of Connections window to manage which logon profiles are currently in use as well as add, modify, and delete logon profiles. You can also use the List of Connections window to view details about a selected profile. The details that you can view in this window include

- general parameters that were defined for the profile, such as the connection ID, the host, the profile name, and a description of the profile
- RFC parameters that were defined for the profile, such as the client, user ID, host, destination, and so on
- TCP/IP parameters that were defined for the profile, such as the host and port
additional RFC parameters that were defined for the profile, such as the gateway host and service, system number, and function.

For detailed information about using the List of Connections window, see “Viewing and Managing Open and Available Connections Using the List of Connections Window” on page 18.

**Viewing and Managing Open and Available Connections Using the List of Connections Window**

To view the open and available connections to SAP BW using the List of Connections window:

1. From the Application Setup window or the Logon to SAP BW window, select the following from the main menu in order to open the List of Connections window:

   ![List of Connections Window: Available Connections](image)

2. Perform one of the following:
   - To display a list of available connections and view details about the available connections, select **Available Connections** from the drop-down list in the upper-left corner of the List of Connections window. Then select the desired connection from the list of available connections to view its details.
   - To display a list of open connections and view details about the open connections, select **Open Connections** from the drop-down list in the upper-left corner of the List of Connections window. Then select the desired connection from the list of open connections to view its details.

The connections correlate to logon profiles, so the connections in the list are displayed by logon profile name. When you select a connection from the list of open or available connections, the right side of the window displays the following tabs:

- **General**
- **RFC**
- **TCP/IP**
- **More RFC**
Display 3.10  List of Connections Window

These tabs enable you to view the logon parameters that were entered in the Advanced Parameters window. For detailed descriptions of these parameters, see “Creating and Using a New Logon Profile” on page 13.

3 Click the desired tab to view specific parameters that are defined for the selected connection.

4 After viewing the connection parameters, click one of the following buttons:
   - **Edit** displays the Logon to SAP BW window, which enables you to modify a previously defined logon profile. This button is available only if you are viewing a list of available connections. For detailed information about modifying an existing logon profile, see “Modifying and Using Existing Logon Profiles” on page 16.
   - **Connect** uses the selected connection to connect to the SAP BW system and logs the user who is associated with this connection on to the SAP BW system. This button is available only if you are viewing a list of available connections.
   - **New** displays the Logon to SAP BW window, which enables you to define a new connection and logon profile. This button is available only if you are viewing a list of available connections. For detailed information about creating a new logon profile, see “Creating and Using a New Logon Profile” on page 13.
   - **Remove** deletes the selected connection and associated logon profile. This button is available only if you are viewing a list of available connections.
   - **Disconnect** disconnects the selected connection from the SAP BW system and logs the user who is associated with connection off of the SAP BW system. This button is available only if you are viewing a list of open connections.
   - **OK** closes the List of Connections window.
   - **Help** displays SAS Help for the List of Connections window.
Logging Off

When you close the SAS/ACCESS Interface to SAP BW, the application prompts you to log off of the SAP BW system to which you are currently connected. Typically, this is how you will log off of the SAP BW system. If you have more than one open connection to the SAP BW system, the SAS/ACCESS Interface to SAP BW displays this log off prompt for each open connection.

You can also log off of the SAP BW system without closing the SAS/ACCESS Interface to SAP BW. This enables you to terminate the connection to the SAP BW system without closing the interface. Then, you can either open a new connection for a defined logon profile, create a new logon profile with which to connect, or work from a defined logon profile that already has an open connection.

Note: The SAP BW system and the SAS/ACCESS Interface to SAP BW allow you to have multiple profiles logged on to the SAP BW system at the same time.

To log off of the SAP BW system, do one of the following:

- From the Logon to SAP BW window or the Application Setup window, select the following:
  - Connections ➤ Logoff

  If you have more than one open connection, the application displays a pop-up menu that lists the open connections. Select the profile for which you want to log off.

  Note: If you log off from the Logon to SAP BW window, remember to click Cancel to close the Logon to SAP BW window. If you click OK, you will log in again.

- From the List of Connections window, select the desired open profile from the list of open connections, and then click Disconnect.

  Note: The Connections menu options are available only when you have the either the Logon to SAP BW window or the Application Setup window open.

For more information about using the List of Connections window, see “Viewing and Managing Logon Profiles Using the List of Connections Window” on page 17.

Setting Up the Required SAS Libraries

Overview of the Required SAS Libraries

Several windows in the SAS/ACCESS Interface to SAP BW require you to specify a SAS library. These SAS libraries are references that identify locations where data is stored. The following libraries are required when using the SAS/ACCESS Interface to SAP BW:
Data Dictionary Library specifies the location into which the extracted SAP BW metadata is saved.

You can use the Application Setup window to identify which library you want to use as the data dictionary library. When you use the Application Setup window to identify this library, you must select the library from a list of previously defined libraries. Therefore, the library must already be defined.

For local hosts, this library is also referred to as the metadata destination in the Load Metadata Wizard, and you can define the library using the Metadata Destination window in the wizard.

Metadata Destination Library specifies the location into which the extracted SAP BW metadata is saved.

You can use the Metadata Destination window, which displays when you run the Load Metadata Wizard, to select a previously defined library or define a new library.

For local hosts, the metadata destination library is also referred to as the data dictionary library. The data dictionary library is specified in the Application Setup window.

Views Destination Library specifies the location in which the views of the SAP BW tables are saved when you extract an ODS object or InfoCube from your SAP BW system.

When you extract data from an ODS table or InfoCube in your SAP BW system, the SAS/ACCESS Interface to SAP BW generates views or data sets that contain the extracted data. The views destination library is the location in which those views or data sets are stored. The views destination library is referred to as the ODS table destination library when you are extracting ODS table data. You can use the Views Destination window in the Extract InfoCube Wizard or the ODS Table Destination window in the ODS Extraction Wizard to select a previously defined library or define a new destination library.

Star Schema Destination Library specifies the location in which the star schema that is created from the SAP BW InfoCube is saved.

When you extract an SAP BW InfoCube, the SAS/ACCESS Interface to SAP BW uses the views to the tables that make up the InfoCube to create a star schema that has one fact table and multiple dimension tables in the star schema destination library. You can then use this star schema in other SAS software applications, such as SAS/Warehouse Administrator.

You can define the required SAS libraries before you begin using the SAS/ACCESS Interface to SAP BW, or you can define them at the time when you are required to identify them. If you decide to set up your SAS libraries before you begin working with the interface to SAP BW, then you can use the SAS Explorer to define the new libraries. If you decide to define the libraries as you need them, most of the windows that require you to specify a SAS library enable you to define the library by using a Define button that is located in that window.

When you are using SAS/CONNECT to connect to a remote host, you can define the star schema destination library and views destination library on the remote host.
However, the metadata destination library must be defined on the local machine because the Load Metadata Wizard can extract data only to the local machine.

*Note:* The only library that you must define before you begin using the SAS/ACCESS Interface to SAP BW is the data dictionary library. For more information about how to define the required SAS libraries, see “Defining the Required SAS Libraries” on page 22.

---

**Defining the Required SAS Libraries**

To define the required libraries:

1. Open the New Library window in one of the following ways:
   - From the main SAS window, select the following:
     - File ➤ New ➤ Library
   - Right-click anywhere in the SAS Explorer window, and then select the following:
     - File ➤ New ➤ Library
   - Click **Define**, which is located next to the **Library Reference** field in the applicable window.

   ![New Library Window](image)

2. In the Library group box of the New Library window, define the library details as follows:

   - **Name** specifies the library reference or name of the library. Enter the desired name. You can use up to eight alphanumeric characters.
   - **Engine** specifies the engine that you want to use for the library. The engine allows SAS to access files with a particular format. There are several types of engines. If you are not sure which engine to choose, use the **Default** engine. For more information about specifying the appropriate engine, click **Help** in the New Library window.
Enable at Startup specifies whether you want SAS to automatically assign the library each time SAS starts. Select the check box if you want the library to be automatically assigned at startup.

3 In the Library Information group box of the New Library window, specify the following additional library information:

Path enables you to specify the complete directory path for the location to which you want to assign this library reference.

Options enables you to specify any options that you want to apply to the library. For more information about the options, click Help in the New Library window.

Note: The fields in the Library Information group box vary depending on the engine that you select. The fields listed previously will display if you select the default engine.

4 Click OK to create the new library. The newly defined library will then display in the drop-down lists for all of the Library Reference fields in the SAS/ACCESS Interface to SAP BW.

5 Repeat steps 1 through 5 as needed to define the data dictionary library, metadata destination library, views destination library, and star schema destination library.

---

Defining the Local Application Defaults

Overview of the Local Application Defaults

The local application parameters define the default location from which data is extracted and the default location to which data is stored. They also define several other parameters that determine how and where the extracted metadata is stored in SAS. The Application Setup window enables you to define these local application parameters.

Display 3.12 Application Setup Window
The Application Setup window contains the following tabs:

**Defaults Tab** enables you to specify the default settings for extracting data from SAP BW. These defaults determine whether data is saved as a view or as a SAS data file and where the extracted data is saved. For more information about using the Defaults tab, see “Defining the General Application Defaults” on page 24.

**Data Dictionary Tab** enables you to specify the default settings that are associated with the data dictionary that contains the source data you want to extract. These defaults determine where the source data that you want to extract is stored and how that data is accessed. For more information about using the Data Dictionary tab, see “Defining the Data Dictionary Defaults” on page 25.

**Miscellaneous Tab** enables you to define a limit for the number of observations to display when showing SAP BW data in the SAP BW Explorer. For more information about using the Miscellaneous tab, see “Defining the Miscellaneous Default” on page 26. For more information about the SAP BW Explorer, see “Browsing SAP BW Metadata” on page 37.

---

**Defining the General Application Defaults**

To define the general application defaults for the SAS/ACCESS Interface to SAP BW:

1. If the Application Setup window is not already displayed, double-click the Local Setup icon on the SAS/ACCESS Interface to SAP BW desktop to open the Application Setup window.
2. Select the Defaults tab from the Application Setup window.

**Display 3.13  Application Setup Window: Defaults Tab**

3. Enter the desired defaults:

   **Host** specifies the target machine on which the extracted data will be saved. Select either -LOCAL- or a remote host (if defined). A remote host is the session ID of a running SAS/CONNECT session. -LOCAL- is the default selection.

   **Library** specifies the location on the selected host in which the SAS view or data file is saved. Select the desired library. **SASUSER** is the default selection.
Getting Started  △  Defining the Data Dictionary Defaults  25

**Type** specifies whether the extracted SAP BW metadata is stored in a SAS view or a SAS data file. Select either **View** or **Data**. **View** is the default selection.

**Replace** determines whether to overwrite the existing view or data file when performing a new extraction. Select **Yes** to overwrite existing views or data sets. Select **No** to leave existing views or data sets untouched. **No** is the default selection.

4 Continue defining the local application defaults by selecting the Data Dictionary and Miscellaneous tabs or click one of the following buttons:

- **OK** saves the defaults that you have entered and closes the Application Setup window.
- **Cancel** cancels any changes that you have made to the local application defaults and closes the Application Setup window.
- **Reset** resets all of the local application defaults to their default values.
- **Help** displays SAS Help for the Application Setup window.

For more information about using the Data Dictionary tab, see “Defining the Data Dictionary Defaults” on page 25. For information about the Miscellaneous tab, see “Defining the Miscellaneous Default” on page 26.

---

**Defining the Data Dictionary Defaults**

To define the data dictionary defaults for the SAS/ACCESS Interface to SAP BW:

1 If the Application Setup window is not already displayed, double-click the Local Setup icon on the SAS/ACCESS Interface to SAP BW desktop to open the Application Setup window.

2 Select the Data Dictionary tab from the Application Setup window.

3 Enter the desired defaults:

- **Access Type** specifies the location of the data dictionary that contains the source SAP BW data that you want to extract. Select either **Local to the Application** or **Remote to the Application**. **Local to the Application** is the default.
Remote Host specifies the remote machine that contains the source data that you want to extract if the data dictionary is remote to the application. The remote host is the session ID of a running SAS/CONNECT session. If the data dictionary is local to the application, this field is disabled.

SAS Library selects the SAS library that identifies the location of the data dictionary. If you are using a local host, this is the same library to which you extract metadata. If you are using a remote host, then you will specify a SAS library that references the location of the metadata on the remote host.

Local Copy of the SAS Library selects the SAS library that identifies the local copy of the data dictionary. If the data dictionary extract resides on a remote host, the (accessed) information can be stored in a local copy for better performance. If the data dictionary is local to the application, this field is disabled.

4 Continue defining the local application defaults by selecting the Defaults and Miscellaneous tabs or click one of the following buttons:

- **OK** saves the defaults that you have entered and closes the Application Setup window.
- **Cancel** cancels any changes that you have made to the local application defaults and closes the Application Setup window.
- **Reset** resets all of the local application defaults to their default values.
- **Help** displays SAS Help for the Application Setup window.

For more information about using the Defaults tab, see “Defining the General Application Defaults” on page 24. For more information about the Miscellaneous tab, see “Defining the Miscellaneous Default” on page 26.

---

**Defining the Miscellaneous Default**

To define the miscellaneous defaults for the SAS/ACCESS Interface to SAP BW:

1 If the Application Setup window is not already displayed, double-click the Local Setup icon on the SAS/ACCESS Interface to SAP BW desktop to open the Application Setup window.

2 Select the Miscellaneous tab from the Application Setup window.

**Display 3.15 Application Setup Window: Miscellaneous Tab**
3 Enter the desired default:

**Limit of observations for Show Data** specifies the maximum number of observations to display for a data query. This limit determines the number of observations that are displayed when you view a table or display the InfoObject details in the BW Explorer window.

4 Continue defining the local application defaults by selecting the Defaults and Data Dictionary tabs or click one of the following buttons:

- **OK** saves the defaults that you have entered and closes the Application Setup window.
- **Cancel** cancels any changes that you have made to the local application defaults and closes the Application Setup window.
- **Reset** resets all of the local application defaults to their default values.
- **Help** displays SAS Help for the Application Setup window.

For more information about using the Defaults tab, see “Defining the General Application Defaults” on page 24. For more information about the Data Dictionary tab, see “Defining the Data Dictionary Defaults” on page 25.
Overview of Extracting and Browsing SAP BW Metadata

After setting up your libraries, profiles, and local application defaults, you must extract metadata from the SAP BW data sources before you can use the SAS/ACCESS Interface to SAP BW to browse SAP BW metadata and extract and export SAP BW data. The Load Metadata Wizard, which is available from the SAS/ACCESS Interface to SAP BW desktop, enables you to easily extract metadata from your SAP BW system. You can extract metadata either interactively or in batch mode. The Load Metadata Wizard uses an ABAP function that issues a single call to your SAP BW system rather than issuing multiple calls. This reduces the amount of time required to extract large amounts of metadata from the ODS objects and InfoCubes in your SAP BW system.

The wizard reads and extracts metadata from the following types of data sources:

- SAP BW InfoCubes
- SAP BW ODS objects

When you extract the SAP BW metadata, it is saved in multiple SAS data sets. You can save the metadata of each data source in a separate library or merge the metadata of all data sources into a single library. After the metadata has been extracted, you can browse it using the BW Explorer.
You can use the BW Explorer to browse the extracted SAP BW metadata, which includes:

- A tree view of the InfoAreas that are defined in your SAP BW system. The tree view displays InfoAreas, basic and aggregate InfoCubes, and active ODS tables that are contained in each InfoArea.
- Data model details about specific SAP BW data sources.
- Table details about specific SAP BW data sources.
- InfoObject details about specific SAP BW data sources.

You can also use the BW Explorer to view and print subsets of the data that is contained in the data sources for which you have extracted metadata. As you browse through the metadata and view subsets of the contents of your data sources, you will be able to learn more about the underlying logic of your SAP BW system. Having knowledge about this logic and about the contents of the data sources in your SAP BW system enables you to identify the data that you want to extract and store in a SAS format. After you have the contents of your SAP BW data sources stored in a SAS file or view, you can more easily access the data for reporting, data analysis, data mining, and so on. For more information about accessing and using your SAP BW metadata, see the following:

- “Extracting SAP BW Metadata” on page 30
- “Browsing SAP BW Metadata” on page 37

---

**Extracting SAP BW Metadata**

---

**Introduction to the Load Metadata Wizard**

SAP BW maintains metadata about its contents in a number of tables. The SAS/ACCESS Interface to SAP BW provides a Load Metadata Wizard that is accessible...
from the SAS/ACCESS Interface to SAP BW desktop. The wizard enables you to extract relevant data from the SAP BW metadata tables. Before you can use the SAS/ACCESS Interface to SAP BW to browse the metadata associated with a specific ODS object or InfoCube, you must first extract the SAP BW metadata that is associated with that ODS object or InfoCube. If you change the structure of an ODS object or InfoCube or reorganize the InfoAreas in your SAP BW system, you should update the extracted metadata.

The Load Metadata Wizard generates SAS source code that is used to read the tables, fields, meta tables, and InfoObjects that compose the data sources that have been defined in your SAP BW system and then store the extracted SAP BW metadata in SAS data sets that are saved in the metadata destination library. To facilitate metadata updates and batch extractions, you can save the automatically generated SAS source code as a SAS program that you can run at a later time.

The Load Metadata Wizard prompts you to specify parameters that determine

- the type of metadata that you want to include in the extraction process. You can extract metadata from any combination of tables, fields, meta tables, and InfoObjects that are defined in your SAP BW system, or you can extract metadata for a specified ODS object or InfoCube only.
- the location of the extracted metadata. You can save the data sets that contain the metadata in individual libraries that contain metadata for specific data sources or you merge all of the data sets that contain the metadata into a single library.
- the location of the SAS source code files that are generated, if you select to save them.

After the extraction process is complete, you can use the BW Explorer to view the extracted SAP BW metadata. For more specific information about extracting your SAP BW metadata, see “Using the Load Metadata Wizard to Extract SAP BW Metadata” on page 31. For information about browsing the metadata, see “Browsing SAP BW Metadata” on page 37.

---

**Using the Load Metadata Wizard to Extract SAP BW Metadata**

To use the Load Metadata Wizard to extract metadata for one or more SAP BW data sources:

1. Double-click the Load Metadata Wizard icon on the SAS/ACCESS Interface to SAP BW desktop to start the Load Metadata Wizard. The wizard starts and displays the Connection to SAP BW window, which identifies the connection ID and displays information about the current connection to the SAP BW system.
Display 4.2  Connection to SAP BW Window

**Note:** The connection ID and connection information are displayed only if you logged on to SAP BW before you started the Load Metadata Wizard. If you have not already established a connection, the fields are blank.

2 If you have not already established a connection to your SAP BW system and need to establish a new connection, or if you want to use a connection other than the one identified in the Connection ID field, specify the connection parameters as follows:

- **Connection ID to SAP BW** specifies the connection ID that will be used to log on to your SAP BW system. To use an existing connection to extract the SAP BW metadata, select one of the open connections by choosing the desired connection ID from the drop-down list. The drop-down list displays connection IDs for all of the currently open connections.

- **New Connection** enables you to define a new connection to SAP BW. To define a new connection, click [New Connection], and then use the Logon to SAP BW window to define the new logon profile and connect to SAP BW with the new connection ID. After defining the connection information, return to the Connection to SAP BW window and select the new profile from the drop-down list at the top of the window.

  For more information about using the Logon to SAP BW window to create a new connection to SAP BW, see “Creating and Using a New Logon Profile” on page 13.

  The display field in the center of the Connection to SAP BW window displays details about the selected connection ID.

3 Click [Next] to display the Metadata Destination window.
Enter the metadata destination parameters as follows:

**Library Reference** specifies the library in which you want to store the extracted SAP BW metadata. Either select the previously created metadata destination library from the drop-down list or click **Define** to create a new metadata destination library. For more information about the metadata destination library, see “Setting Up the Required SAS Libraries” on page 20.

**Merge into Existing Metadata** specifies whether you want to save all of the data sets that contain the extracted metadata in a single SAS library. Select this check box to add the newly extracted metadata to the library that contains the previously extracted metadata. Do not select this check box if you do not want to save the data sets that contain the extracted metadata in a single SAS library.

4 Click **Next** to display the Metadata Type Selection window, which enables you to specify the type of metadata that you want to extract from the SAP BW system.
Display 4.4  Metadata Type Selection Window

Enter the metadata type parameters as follows:

**InfoCube/ODS Metadata only** specifies whether you want to extract metadata for a specified ODS object or InfoCube only. Select this check box and specify the technical name of the ODS object or InfoCube from SAP BW if you want to extract metadata about a specific InfoCube or ODS object. Do not select this check box if you want to extract metadata about more than one ODS object or InfoCube in your SAP BW system.

**Tables** specifies whether you want to extract metadata about all of the active tables in your SAP BW system. Select this check box to extract the following metadata about all of the active tables:
- type of table (Transparent, Internal, or View)
- name of the table
- text description of the table
- human language in which the data in the table was saved.

This check box is selected by default. Deselect this check box if you do not want to extract table metadata from your SAP BW system. This check box is disabled if you selected the **InfoCube/ODS Metadata only** check box.

**Fields** specifies whether you want to extract metadata about the fields (also called columns) in the tables that are defined in your SAP BW system. Select this check box if you want to extract the field metadata, such as
- text description of the field
- name of the table that contains the field
- data type associated with the field
- human language in which the data in the field was saved.

This check box is selected by default. Deselect this check box if you do not want to extract field metadata from your SAP BW system.
system. This check box is disabled if you selected the
InfoCube/ODS Metadata only check box.

**BW Meta Tables** specifies whether you want to extract metadata from the
metadata repository in your SAP BW system. Select this check box if you want to extract the metadata tables in your SAP BW system.

This check box is selected by default. Deselect this check box if you do not want to extract metadata from the metadata repository in your SAP BW system. This check box is disabled if you selected the InfoCube/ODS Metadata only check box.

*Note:* Selecting this check box does not enable you to
extract InfoObject details. To extract InfoObject details, you
must select either the InfoCube/ODS Metadata only check box or the InfoObjects check box.

**InfoObjects** specifies whether you want to extract detail metadata about all of the active InfoObjects that are defined in your SAP BW system. Select this check box to extract detailed information about the InfoObject that you can later browse using the BW Explorer. This check box is selected by default.

Deselect this check box if you do not want to extract InfoObject metadata from your SAP BW system. This check box is disabled if you selected the InfoCube/ODS Metadata only check box.

5 If you are extracting table metadata and you want to limit the number of tables that are extracted, click [Range] to display the Table Subset window, which enables you to specify the exact range(s) of tables to extract.

**Display 4.5 Table Subset Window**

Enter the desired table range using the **From** and **To** fields. The table range uses the alphabetic table names to limit the tables that are extracted. For example, enter **T000** in the **From** field and **T009** in the **To** field to extract metadata for all of the tables with names between **T000** and **T009** in the alphabet. To add an additional range, click [Add]. To delete a range, select the range from the list, and then click [Delete]. The ranges that you specify apply only to the table and field metadata that is extracted.
Click **OK** to save the range that you have entered and close the Table Subset window.

6 Click **Next** to display the Source File Selection window.

**Display 4.6**  Source File Selection Window

Enter the source file parameters as follows:

**Source filename text field** specifies the name of the SAS program in which you want to save the SAS source code that is generated by the wizard and used to extract metadata from the SAP BW system. In the text-entry field, specify the name of the SAS program. You can either enter the filename in the field or you can use the **Browse** button to locate and select the file.

Saving the SAS program enables you to extract the metadata in batch mode; however, you do not have to save the source code to complete the extraction process.

**Replace File if it exists** specifies whether you want to overwrite an existing SAS program. Select this check box if you want to overwrite an existing SAS program. Do not select this check box if you want to create a new SAS program using the specified source filename. This check box is applicable only if you choose to save the SAS program that is used to extract metadata from the SAP BW system.

7 Click **Next** to display the Review Metadata Extraction window, which enables you to review all of the extraction settings that you have defined in the Load Metadata Wizard. Use the scroll bar to view all of the settings.
Display 4.7  Review Metadata Extraction Window

8  Click one of the following buttons:

Help

enables you to display SAS Help for the window.

Cancel

enables you to cancel the metadata extraction process and end the Load Metadata Wizard without extracting metadata from the SAP BW system.

Back

enables you to return to the previous window in order to make changes to the parameters that you have specified for the extraction. You can continue to modify the extraction parameters by continuing to click Back in order to return to each of the windows in the Load Metadata Wizard.

Next

displays the next window in the Load Metadata Wizard. This button is disabled because this is the last window in the wizard.

Finish

begins the extraction process. When the extraction process is complete, a message displays indicating whether the metadata was extracted successfully.

Browsing SAP BW Metadata

Overview of Browsing the SAP BW Metadata

After you have extracted metadata from SAP BW data sources, the BW Explorer, which can be accessed from the SAS/ACCESS Interface to SAP BW desktop, displays the extracted metadata. It lists the InfoAreas, basic and aggregate InfoCubes, and active ODS objects in your SAP BW system and also enables you to view specific metadata about a selected ODS object or InfoCube. If you extracted metadata about a specific InfoCube or ODS object, the BW Explorer displays metadata for that data source only. However, if you selected to extract metadata from all of the active tables, fields, and InfoObjects in your SAP BW system, then the BW Explorer displays metadata for all of the data sources that are defined in your SAP BW system.
After you have extracted your SAP BW metadata, the left panel of your BW Explorer displays a hierarchical tree view of the InfoAreas, basic and aggregate InfoCubes, and active ODS objects that are defined in your SAP BW system. MultiCubes and remote cubes are not included in the tree view. Each InfoArea can consist of one or more data sources, and these data sources can be InfoAreas, InfoCubes, or ODS objects. Some InfoAreas might be empty. You can expand and collapse a selected InfoArea that is displayed in the tree view to see the data sources that compose the InfoArea. When you select one of the data sources in an InfoArea, the tabs in the BW Explorer window display specific metadata details about that SAP BW data source. The tabs in the BW Explorer window include:

**Data Model Tab**

displays a tree view that illustrates the data structure of the selected SAP BW ODS table of InfoCube. The data model metadata identifies the dimensions and analysis variables that make up the data source, and it provides detailed information about the dimensions. For more information about the browsing the data model, see “Using the BW Explorer to Browse SAP BW Metadata” on page 39.

**Tables Tab**

lists the tables in the selected SAP BW data source and displays more detailed metadata about the tables. The table metadata that is displayed includes the type of table, the technical name of the table, and a text description of the table. In addition to viewing table metadata, you can select a table from the list and view or print a subset of the contents of that table. For more information about browsing the table metadata, see “Exploring the Table Metadata” on page 40.

**InfoObjects Tab**

lists and displays detailed metadata for the key figures and characteristics that are associated with the selected SAP BW data source. The InfoObject metadata displayed includes the technical name of the InfoObject, the type of InfoObject, and a text description.
of the InfoObject. You can also select an InfoObject from the list and view or print details about that InfoObject. For more information about browsing the InfoObject metadata, see “Exploring the InfoObject Metadata” on page 42.

Browsing through the SAP BW metadata helps you learn more about the logical structure of your SAP Business Information Warehouse and about the data that is stored in your SAP BW system. You can use this information to identify the specific SAP BW data sources that you want to extract and then use the InfoCube Extraction Wizard to extract the SAP BW data from the data source. For more information about browsing SAP BW metadata and extracting ODS tables and InfoCubes, see

- “Using the BW Explorer to Browse SAP BW Metadata” on page 39
- Chapter 5, “Extracting InfoCubes and Reading ODS Data into SAS,” on page 49.

Using the BW Explorer to Browse SAP BW Metadata

Exploring the Data Model Metadata

To explore or browse the data model metadata that has been extracted for a selected SAP BW data source (ODS object or InfoCube):

1. If the BW Explorer is not already open, open it by double-clicking the SAP BW Explorer icon on the SAS/ACCESS Interface to SAP BW desktop. The left panel of the BW Explorer displays a tree view of all the InfoAreas, basic and aggregate InfoCubes, and active ODS objects that are stored in your SAP BW system.
2. Expand and collapse the tree view as needed to locate the ODS object or InfoCube for which you want to view metadata.
3. Select the desired SAP BW data source to display the data model metadata on the Data Model tab. The data model metadata illustrates the structure of the selected data source.

Display 4.9 BW Explorer: Data Model Tab
4 Expand and collapse the tree view as needed to view the tables that comprise the SAP BW data source. For the selected data source, the following metadata is displayed:

**key figures** displays the analysis variables that are defined for the data source.

**dimensions** indicates the dimensions that are defined for the data source. If you select an ODS object, then two dimensions are displayed: data fields and key fields. If you select an InfoCube, the icons identify the InfoCube dimensions as follows:

- **double blue ball icon** identifies dimensions.
- **double grey ball icon** identifies key figures (analysis variables).
- **single blue ball icon** identifies characteristics of a dimension.
- **blue ball with white ball icon** identifies attributes of characteristics. The attributes are merged from the master tables into the dimensions during the conversion from the snowflake to star schema.
- **blue ball with sum-symbol icon** identifies individual key figures.
- **blue ball with watch icon** identifies time characteristics.
- **blue ball with ruler icon** identifies unit characteristics.

**short name** identifies the descriptive name of the displayed objects. The short name appears with the icon. (No text found) is displayed with the icon if no short description in the selected language is found in the SAP BW system.

**technical name** identifies the technical name of the displayed object. The technical name is displayed in brackets [ ] beside the short name.

### Exploring the Table Metadata

To explore or browse the table metadata that has been extracted for a selected SAP BW data source (ODS object or InfoCube):

1. If the BW Explorer is not already open, open it by double-clicking the SAP BW Explorer icon on the SAS/ACCESS Interface to SAP BW desktop. The left panel of the BW Explorer displays a tree view of all the InfoAreas, basic and aggregate InfoCubes, and active ODS objects that are stored in your SAP BW system.
2 Expand and collapse the tree view as needed to locate the SAP BW data source for which you want to view table metadata.

3 Select the desired data source, then click the Tables tab to display the table metadata.

**Display 4.10** BW Explorer: Tables Tab

![BW Explorer with Tables Tab]

The table metadata is extracted from the meta tables in SAP BW and is displayed in the Tables tab. For InfoCubes, the Tables tab displays all of the tables in the snowflake schema for the selected InfoCube in the SAP BW system. For ODS objects, the Tables tab displays the single active ODS table. The following table metadata is displayed:

- **Type** identifies whether the table is a fact, dimension, SID, text, or master table.
- **Name** identifies the technical name of the table and the location in which the table is stored in the data source.
- **Description** displays a text description of each table in the selected data source.

4 To view a subset of the data for one of the tables:
   a. Select the desired table by clicking in the **Type**, **Name**, or **Description** field for that table.
   b. Click the right mouse button to display the table pop-up menu.
   c. Select **View Table** from the pop-up menu to generate a view that displays a subset of the data that is in the selected table.
42 Using the BW Explorer to Browse SAP BW Metadata

Display 4.11 View Table Window

The range of data that is included in the subset is determined by the Limit of observations for Show Data, which is specified in the Miscellaneous tab of the Application Setup window. For more information about setting or modifying this local application default, see “Defining the Miscellaneous Default” on page 26.

5 To print a subset of the data that a table contains:
   a Select the desired table by clicking in the Type, Name, or Description field for that table.
   b Click the right mouse button to display the table pop-up menu.
   c Select the appropriate option from the pop-up menu:
      Print prints the subset of data.
      Print Preview displays how the subset of data will appear when printed.
      Print Setup enables you to specify print options such as printer and page setup.

Exploring the InfoObject Metadata

To explore or browse the InfoObject metadata that has been extracted for a selected SAP BW data source (ODS object or InfoCube):

1 If the BW Explorer is not already open, open it by double-clicking the SAP BW Explorer icon on the SAS/ACCESS Interface to SAP BW desktop. The left panel of the BW Explorer displays a tree view of all the InfoAreas, basic and aggregate InfoCubes, and active ODS objects that are stored in your SAP BW system.
2 Expand and collapse the tree view as needed to locate the SAP BW data source for which you want to view metadata.
3 Select the desired data source and click the InfoObjects tab to display the InfoObject metadata.
The following InfoObject metadata is displayed:

**Name**
- displays the technical name of the InfoObject.

**Type**
- displays the type of InfoObject. Types include:
  - **CHA** identifies characteristics.
  - **DPA** identifies data packages.
  - **KYF** identifies key figures.
  - **TIM** identifies time characteristics.
  - **UNI** identifies units.

**Description**
- displays a text description of the InfoObject.

4 To view details about the InfoObject:
   a) Select the desired InfoObject by clicking in the **Name**, **Type**, or **Description** field for that InfoObject.
   b) Click the right mouse button to display the InfoObject pop-up menu.
   c) Select **InfoObject Details** from the pop-up menu to generate a view that displays details about the InfoObject.
To print the InfoObject details:

a Select the desired InfoObject by clicking in the **Type**, **Name**, or **Description** field for that InfoObject.
b Click the right mouse button to display the InfoObject pop-up menu.
c Select the appropriate option from the pop-up menu:

- **Print** prints the InfoObject details.
- **Print Preview** displays how the InfoObject details will appear when printed.
- **Print Setup** enables you to specify print options such as printer and page setup.

---

**Saving and Running SAP BW Metadata Extraction Programs**

---

**Overview of Metadata Extraction Programs**

The Load Metadata Wizard generates SAS source code that is used to extract SAP BW metadata from the metadata repository in your SAP BW system. You can save this automatically generated code as a SAS program. You can then re-call the metadata extraction program later to update the views or data sets that contain the SAP BW metadata, or you can use the program in conjunction with a scheduler to perform batch extractions. When using the code in batch extractions, you must modify the code to ensure that the extraction is completed successfully. For more information about saving and using metadata extraction programs, see

- “Using SAP BW Metadata Extraction Programs Interactively” on page 45
- “Using SAP BW Metadata Extraction Programs for Batch Extractions” on page 46.
Using SAP BW Metadata Extraction Programs Interactively

Note: When you want to use a previously saved SAP BW metadata extraction program to interactively extract SAP BW metadata, you must be logged on to the SAP BW system using the same connection ID you used when you saved the metadata extraction program.

To use a previously saved SAP BW metadata extraction program to interactively extract metadata from the metadata repository in your SAP BW system:

1. If it is not already open, open the SAS/ACCESS Interface to SAP BW. To open the application, start a SAS session and then enter `%bwaccess` on the command line.

2. Log on to SAP BW using a logon profile. For more information about logon profiles, see “Using and Managing Logon Profiles” on page 11.

3. If it is not already open, open the Program Editor window. To open the Program Editor window, select the following:

   View ➤ Program Editor

4. Open the file that you want to run by selecting the following and then selecting the file that you want to run from the Open window:

   File ➤ Open

   The selected SAS program displays in the Program Editor window.

Display 4.14  Saved Metadata Extraction Program Displayed in Program Editor Window

5. If you are currently using a connection ID that is different from the one that you used when saving the metadata extraction program, you must modify the source code in order to update the value for the `%r3conn` macro variable. For example, if you saved the program using the EMEA1 connection ID and you are now logged on to the SAP BW system using the CONN1 connection ID, you would need to modify the code by changing...
46 Using SAP BW Metadata Extraction Programs for Batch Extractions

To use a previously saved metadata extraction program to perform batch extractions of SAP BW metadata:

1 If it is not already open, open the Program Editor window. To open the Program Editor window, select the following:

   View ➤ Program Editor

2 Open the metadata extraction program that you want to run by selecting the following and then selecting the file that you want to run from the Open window:

   File ➤ Open
   
   The selected SAS program displays in the Program Editor window.

   Display 4.15  Saved Metadata Extraction Program Displayed in Program Editor Window

3 Edit the source code that is displayed in the Program Editor window in order to add the SAP BW logon and logoff macro calls to the program. Add the logon macro call to the beginning of the program and the logoff macro call to the end of the program. These macro calls are shown in the following example:

   %r3conn=EMEA1;
   to
   %r3conn=CONN1;

   Select the following to submit and run the saved SAS program:

   Run ➤ Submit

   Select the following to check the SAS log for errors:

   View ➤ Log
/* The following code provides an example of the logon macro calls that you must add to the beginning of the program. */

%r3conn(cconn = EMEA1,
       host = localhost,
       port = 6991,
       usr = EMEADEV2,
       pwd = B3BF6F84C44,
       cli = 800,
       lng = EN,
       hst = sunerp2.unx.sas.com,
       sys = 04,
       gws = sapgw04,
       profn = Cary,
       end=);

%let BW_RFC_LOGON_INFO=%str(CLIENT=800 USER=emeadev2 PASSWDX=B3BF6F84C44 LANG=E ASHOST=sunerp2.unx.sas.com SYSNR=04);

/* The following code provides an example of the logoff macro call that you must add to the end of the program. */

%r3conne(cconn=EMEA1, end=);

You can create the %r3conn macro call by re-calling the code that is used by a logon profile. For more information about logging on to the SAP BW system, see “Using and Managing Logon Profiles” on page 11. You must enter the %let BW_RFC_LOGON_INFO macro call manually. This macro call uses the same syntax and parameters as the RFC_LOGON_INFO macro variable in the SAS/ACCESS Interface to R/3. For detailed information about how to use this macro variable, see the SAS/ACCESS Interface to R/3: User’s Guide.

4 Select the following to save the modifications to the SAS program:

   File ➤ Save

5 Select the following to submit and test the modified code:

   Run ➤ Submit

6 Select the following to check the SAS log for errors:

   View ➤ Log

7 Set up your scheduler to run the data extraction program in batch mode as needed. The specific setup instructions vary based on the scheduler that you use. Refer to the documentation for your scheduler for specific instructions.
Overview of Extracting InfoCubes and ODS Table Data into SAS

The SAS/ACCESS Interface to SAP BW provides the InfoCube Extraction Wizard and the ODS Extraction Wizard. These wizards enable you to extract data from the following types of data sources in the SAP BW system: ODS tables and InfoCubes. The wizards, which are available from the BW Explorer, generate SAS source code that is used to

- read the SAP BW data source and create SAS/ACCESS views or data sets from the tables in the SAP BW data source
- convert the SAP BW data that is stored in InfoCubes from a snowflake schema to a star schema and store that star schema in SAS data sets
- store ODS table data into SAS data sets or views
- save the automatically generated source code as a SAS program that you can use later to extract data interactively or in batch mode.

When extracting data from ODS tables and InfoCubes, you can either use full update processing, which extracts all of the data in the selected ODS table or InfoCube, or you can use changed data capture (CDC) processing. CDC processing enables you to extract only the data that has changed since your last extraction. For more information about CDC processing, see

- “Updating Your Metadata and Previously Extracted Data” on page 50
- “Using CDC Processing When Extracting InfoCubes” on page 52
Updating Your Metadata and Previously Extracted Data

The metadata structure in SAS/ACCESS 9.1 Interface to SAP BW has changed in order to differentiate between pre-extracted data that has changed and pre-extracted data that has not changed. If you have previously extracted SAP BW metadata using SAS/ACCESS 8.2 Interface to SAP BW, you must first update any previously extracted metadata before you can use CDC processing. This metadata update is required because the metadata structure has been modified to enable CDC processing. However, no updates to pre-extracted ODS table or InfoCube data are required.

Use the Load Metadata Wizard in SAS/ACCESS Interface to SAP BW to update your previously extracted SAP BW metadata. You will need to

- specify the Metadata Destination Library in the Metadata Destination window. This is the SAS library in which your SAP BW metadata is stored. You must use the metadata destination library that you specified in the SAS Library field in the Data Dictionary tab of the Application Setup window.
- select the Merge into Existing Metadata option in the Metadata Destination window. This option adds the newly extracted metadata to the same library that contains the previously extracted metadata.
- select only the BW Meta Tables option in the Metadata Type Selection window. This option enables you to extract metadata from the SAP BW metadata repository and save it to your metadata destination library.

Note: You only need to update your extracted SAP BW metadata one time regardless of how many ODS tables and InfoCubes there are in your SAP BW system.

Regardless of whether you are extracting a new ODS table or InfoCube or updating previously extracted ODS table or InfoCube data, CDC processing enables you to extract only the changed data. After you have updated your previously extracted SAP BW metadata, updates to ODS table or InfoCube data that you have extracted are not required. You can continue to use previously extracted ODS or InfoCube data. However, for improved performance, it is recommended that you use the full update method when

Note: Because SAP BW does not maintain change logs or timestamps for transactional ODS tables and transactional InfoCubes, you cannot use CDC processing with these transactional data sources.

For more information about how the SAS/ACCESS Interface to SAP BW extracts data from ODS tables and InfoCubes, see

- “Extracting InfoCubes” on page 51
- “Extracting ODS Table Data” on page 55.

For more information about using the InfoCube and ODS extraction wizards and saving and using the data extraction source code, see

- “Extracting InfoCube Data from SAP BW” on page 56
- “Extracting ODS Table Data from SAP BW” on page 64
- “Saving and Running SAP BW Data Extraction Programs” on page 69.
extracting ODS objects and InfoCubes that were previously extracted using Release 8.2 of SAS/ACCESS Interface to SAP BW.

---

**Extracting InfoCubes**

When extracting data from an InfoCube, the InfoCube Extraction Wizard generates SAS source code that reads the InfoCube tables, which are stored in the snowflake schema.

**Figure 5.1 Snowflake Schema**

![Snowflake Schema Diagram](image)

The source code then creates SAS data sets or views that correlate to the fact table, dimension tables, SID tables, text tables, and master tables that make up the InfoCube and merges the SID and master tables with the dimension tables to create a star schema.
The star schema consists of one fact table and multiple dimension tables. The fact table contains logical keys and analysis variables and can be saved as either a SAS view or a SAS data set. The dimension tables are stored as SAS data sets and, rather than containing the SID, they contain the actual values of the class variables. The code can also use default SAS character formats for logical keys and class variables in the fact and dimension tables. If you plan to export the OLAP data that is extracted from the InfoCube to SAS OLAP tools, then the formats are necessary because HOLAP accepts character formatted values only.

The SAS tables that are generated for the star schema use the following naming conventions:

<table>
<thead>
<tr>
<th>Table Type</th>
<th>Concatenation</th>
<th>SAS Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>fact table</td>
<td>F + the SAP BW InfoCube name</td>
<td>F0SD_C01</td>
</tr>
<tr>
<td>dimension tables</td>
<td>D + the appropriate SAP BW dimension table name</td>
<td>D0SD_C011</td>
</tr>
<tr>
<td>star schema view of an InfoCube</td>
<td>I + the SAP BW InfoCube name</td>
<td>I0SD_C01</td>
</tr>
<tr>
<td>format catalog name</td>
<td>F + the InfoCube name</td>
<td>F0SD_C01</td>
</tr>
</tbody>
</table>

*Note:* Format names are restricted to 8 characters. The format description reflects the corresponding variable name and is used to identify the correct format to be used.

*Note:* When you extract InfoCubes from SAP BW, data package (DPA) InfoObjects and their dimensions are not included in the star schema.

**Using CDC Processing When Extracting InfoCubes**

When an InfoCube is updated or modified in your SAP BW system, you might want the data that you extracted from that InfoCube to be updated as well. The InfoCube Extraction Wizard enables you to extract InfoCube data in the following ways:
Use the full update option to extract all of the tables in the InfoCube. This option enables you to extract all of the data in the fact, dimension, SID, master, and text tables that are associated with the snowflake schema for the InfoCube.

Use the CDC processing option to extract only the data that has changed in the fact and dimension tables in the InfoCube. The CDC processing applies only to these tables because SAP BW systems do not support CDC processing on master and text tables.

You can use CDC processing to extract only the data that has changed in the InfoCube in order to update your SAS data sets or views with the changed data. CDC processing enables the InfoCube Extraction Wizard to access the change logs and timestamps that are associated with the fact table and dimension tables in your SAP BW system. The change logs and timestamps enable the wizard to identify and extract data that has changed since your last extraction. However, because SAP BW does not maintain timestamps or change logs on SID tables, text tables and master tables, the InfoCube Extraction Wizard cannot identify changed data in those tables. Therefore, regardless of whether you use CDC processing or the full update method, the InfoCube Extraction Wizard uses the full update method to update the data extracted from text tables, SID tables, and master tables.

You should select the full update option when extracting a new InfoCube or when the InfoCube data was extracted with an earlier version of SAS/ACCESS Interface to SAP BW. Using the full update option on tables that were extracted with an earlier version of the interface improves performance in the new version of the interface. Other factors you should consider when deciding whether to do a full update or use CDC processing include:

- network bandwidth
- the amount of data that needs to be updated
- data consistency and data quality
- processing time in the SAS system.

**Note:** You must use the full update option when an InfoCube has been deleted or rebuilt in your SAP BW system.

For more information about maintaining and ensuring data integrity when you are extracting InfoCube data, see “Extracting Compressed InfoCubes” on page 53 and “Understanding CDC Processing for InfoCubes” on page 54.

**Extracting Compressed InfoCubes**

The SAS/ACCESS Interface to SAP BW enables you to extract data from compressed InfoCubes as well as uncompressed InfoCubes. You can extract compressed InfoCube data using either the full update method or CDC processing. However, if you want to use CDC processing on an InfoCube, you must update the InfoCube before it is compressed in your SAP BW system.

If you load data into an InfoCube in SAP BW and then compress it before updating the InfoCube in SAS/ACCESS Interface to SAP BW, the interface will not be able to find the modified data. Therefore, it will automatically use the full update method on the fact table. This results in extracting both the compressed and the uncompressed table from SAP BW.
In order to use CDC processing when extracting data from compressed InfoCubes, the following sequence of update steps is recommended:

1. Load the data into the InfoCube in SAP BW.
2. Extract the InfoCube data using CDC processing in the SAS/ACCESS Interface to SAP BW.
3. Compress the InfoCube in your SAP BW system.

You should always extract InfoCube data before compressing the InfoCube in SAP BW. If you extract data from an InfoCube that has already been compressed in SAP BW, the InfoCube Extraction Wizard uses the full update method to update the fact table rather than using CDC processing.

### Understanding CDC Processing for InfoCubes

SAP BW bundles transaction data and uses requests to load that data into the uncompressed fact table and the dimension tables of InfoCubes. The package dimension logs which records of the fact table have been loaded through which request. When you compress an InfoCube in SAP BW, a request moves data from an uncompressed fact table to a compressed fact table, and the request information is removed.

SAS/ACCESS Interface to SAP BW uses the package dimension table to track which requests have been loaded into an InfoCube since the last update of the data in the SAS system. Each time you extract data from an InfoCube in SAP BW and write that data to SAS data sets, all of the requests that are associated with loading data into that InfoCube are stored in a SAS data set named 

\[_req<InfoCube-name>\]

The data set that contains the request logs is saved in the star schema destination library, which specifies the location in which the star schema that is created from the SAP BW InfoCube is saved. For example, if you extract data from the 0SD_C01 InfoCube, all of the requests that are associated with that InfoCube are saved in a SAS data set named

\[_req0sd_c01\].

**Note:** You should never modify or remove the data sets that contain the request logs. Modifying or deleting these data sets results in corruption of InfoCube table data such as failed or multiple data updates.

SAS/ACCESS Interface to SAP BW handles requests for typical scenarios as follows:

- **Data has been loaded into the fact table in SAP BW and requests have been compressed before the extracted InfoCube data has been updated in SAS.** In this scenario, SAS/ACCESS Interface to SAP BW refreshes both the compressed fact table and the uncompressed fact table because the compression in SAP BW has eliminated the link between the records in the fact table and the request/load date.
- **Requests have been deleted from the InfoCube.** In this scenario, SAS/ACCESS Interface to SAP BW updates the fact table by deleting the appropriate records.
- **Requests have been loaded into an InfoCube and have not yet been compressed.** In this scenario, SAS/ACCESS Interface to SAP BW leaves the compressed fact table untouched and extracts the newly loaded data from the uncompressed fact table in SAP BW to SAS. The newly loaded data is appended to the fact table in SAS.
- **Requests that had already been updated in SAS have been compressed in SAP BW.** In this scenario, SAS/ACCESS Interface to SAP BW marks the data in the SAS fact table as compressed.

**Note:** SAS/ACCESS Interface to SAP BW provides error handling for fact tables when you use CDC processing. In the event that an error occurs while the fact table is
being updated, the fact table data that is extracted to SAS data sets is not overwritten. Instead, the fact table will be updated the next time you run the InfoCube Extraction Wizard in order to extract data from the selected InfoCube.

**Extracting ODS Table Data**

The ODS Extraction Wizard generates a single SAS table that contains data that is extracted from the active ODS object. Therefore, when you use the wizard to extract data from an ODS table, the wizard generates SAS source code that reads the ODS table and then creates a single SAS data set or view that contains the active data from the ODS table.

When creating the data sets or views, the code uses the original SAP BW ODS table name and attaches a prefix of O. The SAS table that is generated for the ODS table uses the following naming conventions:

<table>
<thead>
<tr>
<th>Table Type</th>
<th>Concatenation</th>
<th>SAS Table Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ODS table</td>
<td>O + name of the ODS object in SAP BW</td>
<td>O0FIAR_00300</td>
</tr>
</tbody>
</table>

**Using CDC Processing When Extracting ODS Table Data**

When an ODS object is updated or modified in your SAP BW system, you might want the data you extracted from that ODS object to be updated as well. CDC processing enables you to extract only the data that has changed in the ODS object. The ODS Extraction Wizard now enables you to extract ODS table data in the following ways:

- Use the full update option to extract all of the active data in the ODS table.
- Use the CDC processing option to extract only the data that has changed in the ODS table since your last extraction.

CDC processing enables the ODS Extraction Wizard to access the change logs and timestamps that are associated with the ODS table in your SAP BW system. The change logs and timestamps enable the wizard to identify and extract data that has changed since your last extraction.

When you use the full update method to extract data from an ODS object, each active record in the ODS table is extracted to SAS. This means that one record is extracted for each active record in the ODS object.

SAP BW bundles transaction data and uses requests to load that data into the ODS object. Change logs and timestamps identify the requests that have been issued since the last ODS extraction. When you use CDC processing to extract data from an ODS object, the ODS Extraction Wizard reads the change logs and timestamps and merges all of the requests that have been issued since the last ODS extraction into the previously extracted ODS data in SAS.

Because of the way that changes are logged in the change log table in SAP BW, in some cases, CDC processing actually extracts more data and might take longer than using the full update method. The following guidelines will help you determine when it is more efficient to use the full update method rather than using CDC processing:
Table 5.3  Using the Full Update Method Versus Using CDC Processing

<table>
<thead>
<tr>
<th>When</th>
<th>Use</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extracting data from a new ODS object</td>
<td>Full Update method</td>
<td>When initially extracting data from an ODS object, the full update method is faster.</td>
</tr>
<tr>
<td>The ODS object was previously extracted using SAS/ACCESS Interface to SAP BW, Release 8.2</td>
<td>Full Update method</td>
<td>Using the full update method for ODS objects that were extracted with an older version of the interface improves performance in the new version of the interface.</td>
</tr>
<tr>
<td>Approximately half of the records in or more the active ODS object have been modified or deleted since the last ODS extraction</td>
<td>Full Update method</td>
<td>The full update method transfers less data and is faster than using CDC processing.</td>
</tr>
<tr>
<td>The majority of the changes since the last ODS extraction have been additions to the active ODS object or less than half of the records have been modified or deleted since the last data extraction</td>
<td>CDC processing</td>
<td>Using CDC processing transfers less data and is faster than using the full update method.</td>
</tr>
</tbody>
</table>

For more information about extracting ODS data, see “Maintaining Data Integrity When Extracting ODS Objects” on page 56.

Maintaining Data Integrity When Extracting ODS Objects

SAP BW bundles transaction data and issues requests to load that data into the ODS objects. SAS/ACCESS Interface to SAP BW uses the change logs and timestamps associated with the ODS objects to track all of the requests associated with the ODS objects since the last update of the data in the SAS system. Each time you extract data from an ODS object in SAP BW and write that data to SAS data sets, all of the requests that are associated with that ODS object are stored in a SAS data set named _req<ODS-object-name>. The data set that contains the request logs is saved in the same library as the ODS table data. For example, if you extract data from the OFIAR_003 ODS object, all of the requests that are associated with that ODS object are saved in a SAS data set named _reqOFIAR_003.

Note: You should never modify or remove the data sets that contain the request logs. Modifying or deleting these log data sets results in corruption of ODS table data such as failed or multiple data updates.

Extracting InfoCube Data from SAP BW

To extract data from an InfoCube in your SAP BW system:

1. If the BW Explorer is not already open, open it by double-clicking the SAP BW Explorer icon on the SAS/ACCESS Interface to SAP BW desktop. The left panel of
the BW Explorer displays a tree view of all the InfoAreas, basic and aggregate InfoCubes, and active ODS objects that are stored in your SAP BW system.

2 Click the desired InfoCube in the left panel of the BW Explorer window.

3 With the InfoCube selected, click the right mouse button to display the extract/export pop-up menu.

4 Select **Extract InfoCube** from the pop-up menu to start the InfoCube Extraction Wizard, which enables you to extract the SAP BW data from the selected InfoCube. The Task Selection window displays.

**Display 5.1 Task Selection Window**

5 Enter the task selection parameters as follows:

**Full Update** enables you to extract all of the SAP BW data from the selected InfoCube. Select this option when

- you have previously extracted the InfoCube using the SAS/ACCESS Interface to SAP BW
- you are extracting data from a new InfoCube
- you want to overwrite an existing extraction of the InfoCube.

This option extracts the complete fact, SID, and dimension tables from SAP BW. This check box is selected by default.

**CDC** enables you to use CDC processing to extract only the InfoCube data that has changed since you last extracted the InfoCube. This option extracts changed data from the SAP BW tables that support CDC processing, which are the fact and dimension tables. This option extracts all of the data in the master, SID, and text tables because they do not support CDC processing.

*Note:* All data that has changed in the fact and dimension tables is extracted, regardless of whether you selected **Full Update** or **CDC** when you last extracted the InfoCube data.
Extract Data enables you to extract SAP BW data from the selected InfoCube. Deselect this check box if you do not want to extract data now, but you do want to create a SAS program that you can run later to extract the data.

Save SAS Source enables you to save the SAS source code that is generated by the application and is used to extract the SAP BW data from the InfoCube. Select this check box if you want to create a SAS program that you can run to extract the data. Saving the SAS source code enables you to run the extraction process at a later date and perform batch extractions of SAP BW data. Saving the SAS source code can also reduce processing time when updating your extracted SAP BW data.

The display field in the center of the Task Selection window displays the technical name and the descriptive name of the InfoCube and provides additional instructions for using the window.

6 Click Next to display the Date Selection window.

Display 5.2 Date Selection Window

Enter the Date that is associated with the master tables and text tables that you want to extract from the InfoCube. The default date is today's date. You can either enter a different date using the DDMMYYYY format or you can click the button to the right of the field to select a date from a calendar.

In SAP BW, master tables and text tables are time-dependent. The date that you specify is the date that is associated with the master table and text tables that are extracted from the SAP BW system.

7 Click Next to display the Host Selection window, which enables you to specify where you want to store the extracted SAP BW data.
Display 5.3  Host Selection Window

Select the **Host** machine to which you want to extract the SAP BW data from the drop-down list. You can select either **-LOCAL-** or the name of the remote host (if defined with SAS/CONNECT). The default value is **-LOCAL-**.

*Note:* If you select a remote host, the SAS CONNECT session on that host must be connected to the SAP BW system using the same connection ID that is currently in use.

8 Click **Next** to display the Views Destination window, which enables you to specify where the extracted InfoCube data is stored.

Display 5.4  Views Destination Window

Specify the destination parameters as follows:

- **Library Reference** specifies the library into which you want to store the data that is extracted from the InfoCube in your SAP BW system. The
default value is the views destination library you specified in the Defaults tab of the Application Setup window. Either select the previously created views destination library from the drop-down list or click [Define] to create a new library. For more information about using the Application Setup window, see “Defining the Local Application Defaults” on page 23. For more information about the views destination library, see “Setting Up the Required SAS Libraries” on page 20.

**Save as Datasets**

enables you to save the extracted InfoCube data in SAS data sets rather than in SAS views. The default file type in which the data is saved can be views or data sets. The default file type is specified in the **Type** field on the Defaults tab of the Application Setup window. Select this check box to save the extracted data in SAS data sets. Deselect this check box to save the extracted data in SAS views. For more information about using the Application Setup window, see “Defining the Local Application Defaults” on page 23.

**Note:** If you selected the CDC option in the Task Selection window, then the fact and dimension tables are automatically stored as permanent SAS data sets. To also save the SID, master, and text tables when using the CDC option, you must select the **Save As Datasets** check box. If you selected the full update option in the Task Selection window, then all of the tables in the InfoCube are saved as permanent SAS data sets regardless of whether you select the **Save as Datasets** check box.

**Replace if targets exist**

select this check box to overwrite previously saved views or data sets. The default for this check box is specified in the **Replace** field on the Defaults tab of the Application Setup window. Select this check box to overwrite views or data sets that were previously saved. Deselect this check box if you want to create new views or data sets. For more information about using the Application Setup window, see “Defining the Local Application Defaults” on page 23.

**Note:** The **Replace if targets exist** check box always applies to the SID, master and text tables in the InfoCube. However, if you selected the full update option in the Task Selection window, then the wizard overwrites any data sets that were previously saved, regardless of whether you select the **Replace if targets exist** check box.

9 Click [Next] to display the Star Schema Destination window, which enables you to specify the location in which the data sets that contain the converted SAP BW data are stored.
Specify the star schema parameters as follows:

**Library Reference**
- specify the library into which you want to store the SAS data sets that contain the SAP BW data that has been converted from a snowflake schema to a star schema. When the conversion process is complete, a fact table, dimension tables, and a star schema view are saved in this library. Either select the previously created star schema destination library from the drop-down list or click **Define** to create a new library. For more information about the star schema destination library, see “Setting Up the Required SAS Libraries” on page 20.

**Create Fact Table as View**
- select this check box if you want to create a SAS view of the fact table when converting the SAP BW data to a star schema format. Do not select this check box if you want to create a SAS data set from the fact table when converting the SAP BW data to a star schema format.

*Note:* If you select this check box, the fact table and the star schema will be accessible only if you are connected to the SAP BW system using the same connection ID that you used when extracting the InfoCube.

10 Click **Next** to display the OLAP Specifics window, which enables you to specify options for exporting the OLAP data from your InfoCube to the SAS OLAP tools.
Display 5.6 OLAP Specifics Window

Specify the OLAP specifics options as follows:

**Create Formats for Logical Keys** specifies whether you want to use default SAS character formats for the logical keys that are stored in the fact table of the star schema. These formats create character values from the numeric logical key values. The formats are assigned to the related fields in the fact and dimension tables and are required if you want to export the extracted InfoCube data to SAS/EIS or any other SAS OLAP tool.

Select this check box to create SAS character formats that convert the values of the logical keys defined for the specified InfoCube.

**Create Formats for Class Variables** specifies whether you want to create SAS formats for the class variables that are stored in the dimension tables of the star schema. The short descriptions from the text tables related to the class variables are used to create formats for the class variables or characteristics. The format is stored in the star schema destination library. The format catalog name is `F` followed by the InfoCube name. The format name is taken from the technical name of the class variable, or if this is not possible due to format name length restrictions, an artificial name is created. The name of the InfoObject is shown in the description of the format. These formats are not automatically assigned to any data set variables.

Select the check box to create SAS character formats for the class variables or characteristics that are defined for the specified InfoCube.

11 Click **Next** to display the Source File Selection window, which enables you to specify where you want to save the SAS source code that is automatically generated by the InfoCube Extraction Wizard.

*Note:* The Source File Selection window displays only if you selected to save the SAS source code that is generated by the InfoCube Extraction Wizard. If you
did not select to save the SAS source code, the Review InfoCube Extraction window displays. Proceed to the next step for instructions about using that window.

Display 5.7  Source File Selection Window

Enter the source file selection parameters as follows:

**Source filename text field** specifies the name of the SAS program in which you want to save the SAS source code that is used to extract the SAP BW data. Enter the complete directory path and filename or click [Browse] to select a previously created file.

**Replace if it Exists** specifies whether to overwrite the file that is identified in the source filename text-entry field. Select this check box to overwrite a previously created file with the SAS source code that is generated for the current extraction. Do not select this check box if you want to append the generated SAS code to an existing file.

12 Click [Next] to display the Review Extraction Settings window, which enables you to view all of the options and parameters that are defined for the InfoCube extraction process.
Display 5.8  Review Extraction Settings Window

Review the options and parameters that you have defined for the InfoCube extraction process.

13 Click one of the following buttons:

- **Help** enables you to display SAS Help for the window.
- **Cancel** cancels the InfoCube extraction process and exits the InfoCube Extraction Wizard.
- **Back** enables you to return to the previous window. You can continue to modify the extraction parameters by continuing to click **Back** in order to return to each of the windows in the InfoCube Extraction Wizard.
- **Next** displays the next window in the InfoCube Extraction Wizard. This button is disabled as the Review Extraction Settings window is the last window available in the wizard.
- **Finish** begins the InfoCube extraction process.

---

**Extracting ODS Table Data from SAP BW**

To extract data from an active ODS table in your SAP BW system:

1. If the BW Explorer is not already open, open it by double-clicking the SAP BW Explorer icon on the SAS/ACCESS Interface to SAP BW desktop. The left panel of the BW Explorer displays a tree view of all the InfoAreas, basic and aggregate InfoCubes, and active ODS objects that are stored in your SAP BW system.
2. Click the desired ODS table in the left panel of the BW Explorer window.
3. With the ODS table selected, click the right mouse button to display the extract pop-up menu.
4. Select **Extract ODS Table** from the pop-up menu to start the ODS Extraction Wizard, which enables you to extract the SAP BW data from the selected ODS object. The Task Selection window displays.
Enter the task selection parameters as follows:

**Full Update** enables you to extract all of the SAP BW data from the selected ODS object. Select this check box to extract all of the records in the active ODS table in your SAP BW system. The extracted data is saved in the same library in which the ODS table data is saved. This check box is selected by default.

**CDC** enables you to use CDC processing to extract only the ODS table data that has changed since you last extracted the ODS data. Select this check box to extract changed data from the ODS table in your SAP BW system. The extracted data is saved in the same library in which the ODS table data is saved.

**Extract Data** enables you to extract SAP BW data from the selected ODS table. Deselect this check box if you want to create a SAS program that you can run later to extract the data rather than extracting the data now.

**Save SAS Source** enables you to save the SAS source code that is generated by the application and is used to extract the SAP BW data from the selected data source. Select this check box if you want to create a SAS program that you can run to extract the data. Saving the SAS source code enables you to run the extraction process at a later date and perform batch extractions of SAP BW data. Saving the SAS source code can also save you time when updating your extracted SAP BW data.

The display field in the center of the Task Selection window displays the technical name and descriptive name of the ODS table and provides additional instructions for using the window.

Click **Next** to display the Host Selection window, which enables you to specify where you want to store the extracted SAP BW data.
Select the **Host** machine name to which you want to extract the SAP BW data from the drop-down list. You can select either **-LOCAL-** or the name of the remote host (if defined with SAS/CONNECT). The default value is **-LOCAL-**.

*Note:* If you select a remote host, the SAS CONNECT session on that host must be connected to the SAP BW system using the same connection ID that is currently in use.

7 Click **Next** to display the ODS Table Destination window, which enables you to specify where extracted ODS table data is stored.

**Display 5.11 ODS Table Destination Window**

Specify the ODS table destination parameters as follows:

- **Library Reference** specifies the library into which you want to store the data that is extracted from the ODS table in your SAP BW system.
Either select the previously created ODS table destination library from the drop-down list or click [Define] to create a new ODS table destination library.

**Create ODS Table as View** enables you to save the extracted ODS table data in a SAS view rather than a SAS data set. By default, the data extracted from an ODS table is saved in a SAS data set.

**Note:** This check box applies only if you use the full update method. If you use CDC processing, the data is always saved in a SAS data set.

**Replace target if it exists** specifies whether to overwrite a previously saved SAS data set or view. Select this check box to overwrite views or data sets that were previously saved. Deselect this check box if you want to create new views or data sets.

**Note:** This check box applies only if you use the full update method. If you use CDC processing, the data is always overwritten.

8 Click [Next] to display the Source File Selection window, which enables you to specify where you want to save the SAS source code that is automatically generated by the ODS Extraction Wizard.

**Note:** The Source File Selection Window displays only if you selected to save the SAS source code that is generated by the ODS Extraction Wizard. If you did not select to save the SAS source code, the Review Extraction Settings window displays. Proceed to the next step for instructions about using that window.

**Display 5.12 Source File Selection Window**

Enter the source file selection parameters as follows:

- **Source filename text** specifies the name of the SAS program in which you want to save the SAS source code used to extract the SAP BW data.
- **field** Enter the complete directory path and filename in the source
filename text-entry field or click [Browse] to select a previously created file.

**Replace if it Exists** specifies whether to overwrite the file identified in the source filename text-entry field. Select this check box to overwrite a previously created file with the SAS source code generated for the current extraction. Do not select this check box if you want to append the generated SAS code to an existing file.

9 Click [Next] to display the Review Extraction Settings window, which enables you to view all of the options and parameters that are defined for the ODS extraction process.

**Display 5.13** Review Extraction Settings Window

Review the options and parameters that you have defined for the ODS extraction process.

10 Click one of the following buttons:

- [Help] enables you to display SAS Help for the window.
- [Cancel] cancels the ODS extraction process and exits the ODS Extraction Wizard.
- [Back] enables you to return to the previous window. You can continue to modify the extraction parameters by continuing to click [Back] in order to return to each of the windows in the ODS Extraction Wizard.
- [Next] displays the next window in the ODS Extraction Wizard. This button is disabled as the Review Extraction Settings window is the last window available in the wizard.
- [Finish] begins the ODS object extraction process.
Saving and Running SAP BW Data Extraction Programs

Overview of SAP BW Data Extraction Programs

The InfoCube Extraction Wizard and ODS Extraction Wizard generate SAS source code that is used to extract SAP BW data from an ODS object or InfoCube in your SAP BW system. The Source File Selection window in the wizards enables you to save this automatically generated code as a SAS program. After you have saved a data extraction program, you can re-call the program later to update the views or tables that contain the extracted ODS or InfoCube data, or you can use the program in conjunction with a scheduler to perform batch extractions.

The automatically generated code consists of the following components:

- macro variables
- PROC DISPLAY function call
- code generated by PROC DISPLAY

*Note:* For more information about macro variables and the PROC DISPLAY function call, see the SAS online Help and user documentation.

When using the saved code you might want to make changes to some of the automatically generated macro variables such as BWrefdate, which is the date that is associated with the master and text tables that are time-dependent in your SAP BW system. The format of the BWrefdate must be `YYYYMMDD`. If you plan to use the saved program in batch extractions, you must add the macro calls that are required to log on to and off of the SAP BW system.

For more detailed information about using the data extraction programs, see

- “Using SAP BW Data Extraction Programs Interactively” on page 69
- “Using SAP BW Data Extraction Programs for Batch Extractions” on page 70.

Using SAP BW Data Extraction Programs Interactively

To use a previously saved data extraction program to interactively extract data from an ODS object or InfoCube in your SAP BW system:

1. If it is not already open, open the SAS/ACCESS Interface to SAP BW. To open the application, start a SAS session and then enter `%bwaccess` on the command line.

2. Log on to SAP BW using a logon profile. For more information about logon profiles, see “Using and Managing Logon Profiles” on page 11.

3. If it is not already open, open the Program Editor window. To open the Program Editor window, select the following:
4 Open the data extraction program that you want to run by selecting the following and then selecting the file that you want to run from the Open window:

**File ➤ Open**

The selected SAS program displays in the Program Editor window.

**Display 5.14** Data Extraction Program Displayed in the Program Editor Window

5 Select the following to submit and run the saved SAS program:

**Run ➤ Submit**

6 Select the following to check the SAS log for errors:

**View ➤ Log**

---

**Using SAP BW Data Extraction Programs for Batch Extractions**

To use a previously saved data extraction program to extract data from an ODS object or InfoCube in batch mode:

1 If it is not already open, open the SAS/ACCESS Interface to SAP BW. To open the application, start a SAS session and then enter `%bwaccess` on the command line.

2 Log on to SAP BW using a logon profile. For more information about logon profiles, see “Using and Managing Logon Profiles” on page 11.
3 If it is not already open, open the Program Editor window. To open the Program Editor window, select the following:

View ➤ Program Editor

4 Open the data extraction program that you want to run by selecting the following and then selecting the file that you want to run from the Open window:

File ➤ Open

The selected SAS program displays in the Program Editor window.

Display 5.15 Data Extraction Program Displayed in the Program Editor Window

5 Edit the source code that is displayed in the Program Editor window in order to add the BW logon and logoff macro calls to the program. Add the logon macro calls to the beginning of the program and the logoff macro calls to the end of the program. These macro calls are shown in the following example:

/* The following code provides an example of the logon macro call that you must add to the beginning of the program. */

%r3conn(cconn = EMEA1,
     host   = localhost,
     port   = 6991,
     usr    = EMEADEV2,
     pwd    = B3BF6BF8C44,
     cli    = 800,
     lng    = EN,
     hst    = sunerp2.unx.sas.com,
sys = 04,
gws = sapgw04,
profn = Cary,
end=;)

/* The following code provides an example of the logoff macro call that you must add to the end of the program. */
%r3conne(cconn=EMEA1, end=);

You can create the %r3connc macro call by re-calling the code that is used by a logon profile. For more information about logging on to the SAP BW system, see “Using and Managing Logon Profiles” on page 11. For detailed information about using this macro call, see the SAS/ACCESS Interface to R/3: User’s Guide.

If you want the program to automatically use the current date as the BWrefdate when performing the extraction, you can add the following code before the PROC DISPLAY call:

%let BWrefdate=%sysfunc(today(), yymmddn8.);
%put %BWrefdate;

Select the following to save the modifications to the SAS program:

File ➤ Save

Select the following to submit and test the modified code:

Run ➤ Submit

Select the following to check the SAS log for errors:

View ➤ Log

Set up your scheduler to run the data extraction program in batch mode as needed. The specific setup instructions vary based on the scheduler that you use. Refer to the documentation for your scheduler for specific instructions.
Overview of Exporting OLAP Metadata to SAS

The SAS/ACCESS Interface to SAP BW offers an Export OLAP Metadata Wizard that enables you to export OLAP metadata about the data model of an InfoCube to SAS. During the export process, the wizard generates SAS source code that you can use later to export the metadata in batch mode. Exporting the OLAP metadata is optional. However, by exporting the OLAP metadata to SAS/EIS you can generate more detailed reports from your SAP BW data.

Before using the Export OLAP Metadata Wizard, you must

- install either SAS/MDDB Server software and SAS/EIS or SAS/OLAP Server.
- define and register the SASUSER metabase repository, which is the default repository. You must name the repository in uppercase letters. You can define additional repositories if desired. Refer to your SAS/EIS documentation for instructions about defining and managing metabase repositories.
- use the InfoCube Extraction Wizard in the SAS/ACCESS Interface to SAP BW to extract InfoCube data from your SAP BW system.

**Note:** If you plan to use the Export OLAP Metadata Wizard, it is recommended that you either have experience working with SAS/EIS software and with setting up and managing repositories or that you have your SAS/EIS documentation available. △

When you use the InfoCube Extraction Wizard to extract SAP BW data from an InfoCube, the extracted data is stored in SAS data sets that comprise a star schema view of the InfoCube. The Export OLAP Metadata Wizard

- uses the information in the star schema view of the InfoCube to generate metadata for the Multidimensional Data Provider. The Multidimensional Data Provider is a data model that handles queries for many different OLAP storage formats including star schemas.
- saves the metadata in a data group and registers the data group in the SAS metabase so that it can be used in
  - multidimensional reports that are created using SAS/EIS software
  - AppDev Studio
Multidimensional Report Viewer
the OLE DB for OLAP component in SAS/MDDB Server software.

The metabase registration can include additional information about column formats and labels, formats, and so on.

After the wizard registers the metadata in the SAS metabase repository, you can use SAS/EIS to generate detailed reports from the extracted SAP BW data. SAS/EIS offers a wide range of business reporting objects, providing a choice of styles for dynamic display and interactive analysis. These reporting objects have multiple levels with built-in drill-down capabilities for fast navigation through your data. For more information about how you can use SAS/EIS, refer to your SAS/EIS documentation.

For more information about using the Export OLAP Metadata Wizard, see “Exporting OLAP Metadata to SAS/EIS” on page 74. For specific instructions about using the reporting features in SAS/EIS, refer to your SAS/EIS documentation.

Exporting OLAP Metadata to SAS/EIS

Note: You must define and register the default SAS metabase repository before you can use the Export OLAP Metadata Wizard. The default repository must be defined as SASUSER and must be defined in uppercase letters. If you have not defined the default repository, the wizard displays an error message that indicates that the default repository could not be generated. For information about defining and managing repositories, refer to your SAS/EIS documentation.

To export OLAP metadata extracted from an InfoCube in your SAP BW system to SAS/EIS:

1 If the BW Explorer is not already open, open it by double-clicking the SAP BW Explorer icon on the SAS/ACCESS Interface to SAP BW desktop. The left panel of the BW Explorer displays a tree view of all the InfoAreas, basic and aggregate InfoCubes, and active ODS objects that are stored in your SAP BW system.

2 In the left panel of the BW Explorer window, click the InfoCube for which you want to export OLAP metadata.

Note: You must extract InfoCube data before you can export OLAP metadata that is associated with that InfoCube to SAS/EIS. For more information about extracting InfoCube data, see “Extracting InfoCube Data from SAP BW” on page 56.

3 With the InfoCube selected, click the right mouse button to display the extract/export pop-up menu.

4 Select Export OLAP Metadata from the pop-up menu to start the Export OLAP Metadata Wizard and display the InfoCube Location window. The wizard enables you to export OLAP metadata to SAS/EIS. The OLAP metadata that is exported is the metadata that is associated with the selected InfoCube.
5 In the **Library Reference** field, specify the library into which you saved the data sets that contain the star schema for the extracted InfoCube data.

Either select the previously created star schema destination library from the drop-down list or click **Define** to create a new library. For more information about the star schema destination library, see “Setting Up the Required SAS Libraries” on page 20.

6 Click **Next** to display the Repository Selection window, which enables you to select the SAS/EIS repository into which you want to save the OLAP metadata.

7 Select an existing repository from the drop-down list or click **Define** to open the Add a New Repository window to create and register a new **Repository**.
Display 6.3 Add a New Repository Window

If necessary, enter the repository parameters as follows, and then click the **OK** button to add the new repository:

- **Repository Name** specifies the name of the SAS/EIS repository that is used to store the OLAP metadata that is associated with the exported InfoCube.
- **Repository Path** specifies the location of the SAS/EIS repository that is used to store the OLAP metadata that is associated with the exported InfoCube. Enter the complete path and filename or click **Browse** to select the appropriate location.
- **Repository Description** specifies a text description of the SAS/EIS repository that is used to store the OLAP metadata that is associated with the exported InfoCube.

*Note:* For more information about creating and registering new repositories, refer to your SAS/EIS documentation.

Click **Next** to display the Registration Settings window, which enables you to define the registration information that is associated with the data group that is used to store the OLAP metadata.

Display 6.4 Registration Settings Window
Specify the registration settings as follows:

**Data Group Name** specifies the name of the data group in which the exported OLAP metadata is saved. The data group containing the OLAP metadata is registered in the SAS/EIS metabase. The default value is I followed by the SAP BW technical name of the InfoCube. For example, for an InfoCube with a technical name of **0SD_C01**, the default data group name is **I0SD_C01**. Enter a different data group name if desired. The data group name must be a valid SAS name.

**Description** specifies a text description of the data group in which the exported OLAP metadata is saved. The default value is **InfoCube** followed by the SAP BW technical name of the InfoCube. For example, for an InfoCube with a technical name of **0SD_C01**, the default data description is **InfoCube 0SD_C01**. Enter a different data group description if desired.

**Replace Existing Registration** specifies that you want to overwrite the saved registration settings for this data group. Select this check box to overwrite previously saved registration settings. Do not select this check box if you want to write registration settings for a new data group.

9 Click **Next** to display the Source File Selection window, which enables you to specify where you want to save the SAS source code that is automatically generated by the export OLAP metadata Wizard.

**Display 6.5  Source File Selection Window**

Enter the source file selection parameters as follows:

**Source filename text field** specifies the name of the SAS program in which you want to save the SAS source code that is used to export the OLAP metadata to SAS/EIS. Enter the complete directory path and filename or click **Browse** to select a previously created file.

**Replace File if it exists** specifies whether to overwrite the file identified in the source filename text-entry field. Select this check box to overwrite a
previously created file with the SAS source code generated for the current extraction. Do not select this check box if you want to create a new file.

10 Click **Next** to display the Review Export Metadata Window, which enables you to view all of the options and parameters that are defined for the export process.

**Display 6.6**  Review Export Metadata Window

Review the options and parameters that you have defined for the export process.

11 Click one of the following buttons:

- **Help** enables you to display SAS Help for the window.
- **Cancel** cancels the export OLAP metadata process and exits the Export OLAP Metadata Wizard.
- **Back** enables you to return to the previous window. You can continue to modify the extraction parameters by continuing to click **Back** in order to return to each of the windows in the Export OLAP Metadata Wizard.
- **Next** displays the next window in the Export OLAP Metadata Wizard. This button is disabled as the Review Export window is the last window that is available in the wizard.
- **Finish** begins the export process.
Recommended Reading

Here is the recommended reading list for this title:

- *Doing More with SAS/ASSIST*
- *Getting Started with the SAS System*
- *SAS/ACCESS Interface to SAP BW: User’s Guide*
- *Getting Started with the SAS System in the MVS Environment*
- *SAS/AF Procedure Guide*
- *SAS/FSP Procedures Guide*
- *SAS Language Reference: Concepts*
- *SAS Language Reference: Dictionary*
- *SAS Macro Language: Reference*
- *SAS/Warehouse Administrator Metadata API Reference*
- *SAS/Warehouse Administrator User’s Guide*
- *Step-by-Step Programming with Base SAS Software*
- *Getting Started with SAS/ASSIST*
- *SAS® Companion that is specific to your operating environment.*

For a complete list of SAS publications, see the current SAS Publishing Catalog. To order the most current publications or to receive a free copy of the catalog, contact a SAS representative at

SAS Publishing Sales
SAS Campus Drive
Cary, NC 27513
Telephone: (800) 727-3228*
Fax: (919) 677-8166
E-mail: sasbook@sas.com
Web address: support.sas.com/pubs
* For other SAS Institute business, call (919) 677-8000.

Customers outside the United States should contact their local SAS office.
Glossary

BEx
See Business Explorer.

Business Explorer (BEx)
the user interface for front-end reporting and analysis in SAP BW. The Business Explorer enables SAP BW users to display standard reports in Microsoft Excel spreadsheets and performs ad hoc analyses for customized reporting.

class variable
a variable that is used to group or classify data. In SAS/EIS software, characteristics can be used as class variables. See also characteristic.

CPI-C
Common Programming Interface–Communications. An application-level interface for direct program-to-program communication.

data source
in the SAS/ACCESS Interface to SAP BW, an ODS object or InfoCube.

dimension table
a table that stores characteristics of an InfoCube that are used to categorize key figures.

fact table
a table that stores the key figures of an InfoCube.

InfoCube
a set of relational tables in SAP BW that contains characteristics and key figures. InfoCubes are stored in snowflake schemas and are comprised of one fact table and multiple dimension tables, SID tables, text tables, and master tables. In SAP BW, data that is stored in InfoCubes is used for analysis and reporting.
InfoObject
a metadata object that either describes an ODS object, or describes a characteristic or key figure of an InfoCube. In the SAS/ACCESS Interface to SAP BW, InfoObjects are displayed in the BW Explorer window. The BW Explorer window enables users to browse InfoCube or ODS table metadata that is extracted from SAP BW.

key figure
a numeric value, such as revenue or sales figures, that is stored in the fact table of an InfoCube. In the SAS/ACCESS Interface to SAP BW, key figure data is copied from the fact table in SAP BW and is stored in SAS data sets or views.

logical key
a unique numeric key that links a dimension table in a star schema to the fact table. Each logical key in the fact table identifies a row in the associated dimension table. In SAS/EIS software, logical keys can be used as class variables if you specified that you wanted to create formats for logical keys when you ran the InfoCube Extraction Wizard.

master table
a table that contains dependent attributes for a characteristic. A master table is one of the types of relational tables that comprise an InfoCube.

ODS object
in SAP BW, an operational data store. ODS object data is stored in a non-aggregated, de-normalized set of flat tables. That is, individual data values are not grouped or summarized. An ODS object consists of only one table, whereas an InfoCube consists of sets of tables.

QueryCube
a collection of selected characteristics and key figures that are used to analyze an InfoCube. Although you can define multiple queries for an InfoCube, each query that you define refers to only one InfoCube. In SAP BW, QueryCubes are defined in the Business Explorer. See also Business Explorer.

R/3
an enterprise resource planning (ERP) system that has been developed by SAP AG for use in client-server environments.

RFC
Remote Function Call. The RFC is the SAP AG implementation of a remote procedure call. RFCs enable external applications such as SAS and other R/3 systems to access SAP BW.

SAP BW
SAP Business Information Warehouse. SAP BW is a data warehousing application that has been developed by SAP AG. Like R/3, SAP BW is an enterprise resource planning system that has been developed for use in client-server environments.

SAP BW data source
See data source.

SID table
a surrogate ID (SID) table that is used to link a master table and the hierarchy tables outside the dimensions of a schema.

text table
a table that contains descriptive attributes for a characteristic. Text tables can contain time-dependent or language-dependent data, as well as other types of descriptive data. A text table is one of the types of tables that comprise an InfoCube.
Index

A
accessing data 4
extracting data 8
methods for 5
storing data 4
Adabas 8
Application Setup window 11 24

B
batch extractions
data extraction programs 70
metadata extraction programs 44 46
Browsing metadata
See metadata, browsing
BW Explorer 37
browsing metadata 30 39
data model metadata 38 39
InfoObject metadata 38 42
subsetted data 30
table metadata 38 40
BW Explorer window 11

C
CDC processing
extracting InfoCubes 52
extracting ODS table data 53
compressed InfoCubes 53
Connection to SAP BW window 11
connections
List of Connections window 12 17 18
remote host 8
viewing and managing 18

D
data, extracting 8
See also InfoCube data, extracting
See also ODS table data, extracting
data extraction programs 69
data access method 8
data dictionary
defining defaults 25
Data Dictionary Library 21
data extraction programs 69
batch extractions 70
interactive extractions 69
saving and running data integrity
extracting ODS objects 56
data model metadata 38 39
data storage 38 23
default settings 25
Data dictionary defaults 25
general application defaults 24
local application defaults 26
desktop 10

E
Export OLAP Metadata Wizard 73
exporting OLAP data 61
exporting OLAP metadata
Export OLAP Metadata Wizard 73
to SAS 73
to SAS/EIS 74
extracting data 4
See also InfoCube data, extracting
See also ODS table data, extracting
data extraction programs 69
extracting InfoCube data
data access method 8
InfoCube data, extracting
See metadata, extracting
See metadata, extracting metadata
data extraction programs 69
extracting ODS objects 56

G
general application defaults
defining 24

I
InfoAreas 4 37
InfoCube data, extracting 69
CDC processing for
compressed InfoCubes 55
data extraction programs 69
exporting OLAP data 61
exporting OLAP metadata to SAS 75
exporting OLAP metadata to SAS/EIS 74
from SAP BW 56
naming conventions 52
process of 8
snowflake schema 51
star schema 53
updating metadata 50
updating previously extracted data
InfoCube Extraction Wizard 49
data extraction programs 69
InfoCubes
browsing metadata 37
compressed 53
extracting metadata 30
snowflake schema 4
star schema 6
storing data 4
InfoObject metadata 38 42
InfoObjects 6
Informix 6
interactive extractions 69
data extraction programs 69
metadata extraction programs 15

L
libraries
defining 22
setting up 20
List of Connections window 12 17 18
Load Metadata icon 10
Load Metadata Wizard icon 11
local application defaults
defining 23
Local Setup icon 10
logging off 20
Logon icon 10
logon profiles 11
creating 13
List of Connections window and 12 17
logging off 20
modifying 16
RFC services and viewing and managing connections
Logon to SAP BW window 11

Index

metadata
data model metadata 39
InfoObject metadata 38, 42
table metadata 38, 40
updating InfoCube metadata 50
updating ODS table data metadata 50
metadata, browsing
BW Explorer 30, 39
InfoCubes 37
InfoObject metadata 38, 42
table metadata 38, 40
metadata, exporting (OLAP)
Export OLAP Metadata Wizard to SAS 73
to SAS/EIS 74
metadata, extracting
batch extractions 46
extraction programs 44
extraction programs, saving and running
InfoCubes and 30
interactive extractions 45
Load Metadata icon 10
Load Metadata Wizard 20, 31
Load Metadata Wizard icon 11
ODS objects 20
Metadata Destination Library 31
Metadata Destination window metadata extraction programs
batch extractions 44
interactive extractions 45
Metadata Type Selection window miscellaneous defaults defining 26

naming conventions
extracting InfoCube data 52

extracting ODS table data 55
New Library window 22

O
ODBO (OLE DB for OLAP) 3
ODS Extraction Wizard 49
ODS objects
data integrity when extracting metadata 56
ODS table data, extracting
CDC processing for data extraction programs from SAP BW 64
naming conventions 55
ODS Extraction Wizard
updating metadata 50
updating previously extracted data 50
ODS Table Destination Library 21
OLAP data exporting 61
OLAP metadata
Export OLAP Metadata Wizard exporting to SAS 73
exporting to SAS/EIS 74
OLE DB for OLAP (ODBO) 5
Oracle 6

R
R/3 6
remote host connections 7
Review Metadata Extraction window 36
RFC services 11

S
SAP Business Information Warehouse
See SAP BW

SAS
accessing data 8
data access method 8
extracting InfoCube data from
extracting ODS table data from
SAS/CONNECT software with 7
SAP BW Explorer icon 10, 11
SAS
exporting ODS table data to 73
SAS/ACCESS Interface to SAP BW See SAP BW
SAS/CONNECT software
SAP BW with 7
SAS/EIS software
exporting OLAP metadata to snowflake schema 74
Source File Selection window 36
star schema 21, 51
Star Schema Destination Library 21
storing data 23
subsetted data 50

T
table metadata 38, 40
Table Subset window 35
tree view 38

U
updating
InfoCube metadata 50
ODS table data metadata 50

V
Views Destination Library 21
If you have comments or suggestions about *SAS/ACCESS\textsuperscript{*} 9.1 Interface to SAP BW: User’s Guide*, please send them to us on a photocopy of this page, or send us electronic mail.

For comments about this book, please return the photocopy to

SAS Publishing  
SAS Campus Drive  
Cary, NC 27513  
E-mail: yourturn@sas.com

For suggestions about the software, please return the photocopy to

SAS Institute Inc.  
Technical Support Division  
SAS Campus Drive  
Cary, NC 27513  
E-mail: suggest@sas.com